Copyright and Disclaimer

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means electronic, mechanical, photocopying, recording, or otherwise without the prior written permission of CyberLink Corporation.

To the extent allowed by law, POWERDIRECTOR IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION ANY WARRANTY FOR INFORMATION, SERVICES, OR PRODUCTS PROVIDED THROUGH OR IN CONNECTION WITH POWERDIRECTOR AND ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, EXPECTATION OF PRIVACY, OR NON-INFRINGEMENT.

BY USING THIS SOFTWARE, YOU AGREE THAT CYBERLINK WILL NOT BE LIABLE FOR ANY DIRECT, INDIRECT, OR CONSEQUENTIAL LOSS ARISING FROM THE USE OF THIS SOFTWARE OR MATERIALS CONTAINED EITHER IN THIS PACKAGE.

The terms and conditions here under shall be governed and construed in accordance with the laws of Taiwan.

PowerDirector is a registered trademark along with other company and product names mentioned in this publication, used for identification purposes and remain the exclusive property of their respective owners.

International Headquarters

Mailing Address  
CyberLink Corporation  
15F, #100, Min Chuan Road, Hsin Tian City  
Taipei County, Taiwan, R.O.C.

Web Site  
www.gocyberlink.com

Telephone  
886-2-8667-1298

Fax  
886-2-8667-1300

Copyright © 2005 CyberLink Corporation. All rights reserved.
Contents

Introduction ................................................... 1
Welcome! .............................................................2
Where to Begin Reading ............................................2
The Movie-Making Process .............................................3
Pre-Production .......................................................3
Putting Your Story Together ......................................3
Editing ......................................................................4
Producing and Burning Your Movie .............................4
Register Your Software .............................................5
Uninstall Your Software ..........................................6
Uninstall from the Start Menu ....................................6
Uninstall from the Control Panel ..............................6
The PowerDirector Program .....................................7
PowerDirector Modes .............................................8
PowerDirector Projects ...........................................8
System Requirements .............................................9
PowerDirector Versions .........................................10
Capturing Media ...................................................... 11
  Capture Mode .......................................................... 12
  Capture Preferences ...................................................... 13
  Capture Options ......................................................... 14
    Capture Limit Options ............................................. 14
    Profile Options ..................................................... 15
    Analog Video Capture Options ................................. 16
    Audio Capture Options .......................................... 17
    Webcam Video Capture Options .............................. 18
    CD/Microphone Capture Profile Setup ...................... 19
    Captured Clip Options ............................................ 19
  Capture from DV Camcorder .......................................... 21
    Capture a Single Scene .......................................... 21
    Batch Capture ....................................................... 23
  Capture from TV .......................................................... 30
  Capture from Webcam .................................................. 32
  Capture from Microphone ............................................ 33
  Rip Audio Tracks from CD ............................................ 34
  Record a Voice-Over ................................................ 35

Creating Your Story .............................................. 37
  Working with Project Files ........................................... 38
    Create a New Project ............................................. 38
    Save a Project ...................................................... 38
    Open an Existing Project ....................................... 38
    New Workspace ...................................................... 38
    View Project Properties ....................................... 39
  General Preferences .................................................. 40
    File Preferences .................................................... 40
    General Preferences ............................................... 41
  The Library .............................................................. 43
    Media Room ........................................................ 44
    Effect Room ........................................................ 44
    Title Room .......................................................... 44
    Transition Room .................................................... 44
    Audio Mixing Room ............................................... 44
    Voice-Over Recording Room .................................. 45
Chapter Setting Room .................................................................45
Managing Media in the Library .......................................................46
  Load Clips into the Library ......................................................46
  Sort Clips in the Library ..........................................................47
  Remove a Clip from the Library .............................................48
  Rename a Clip in the Library ..................................................49
  Restore a Clip’s Original File Name ........................................49
  View Clip Properties .............................................................50
  Detect Scenes in a Video Clip ................................................51
Managing Clips in the Workspace ..................................................53
  Timeline View ........................................................................53
  Storyboard View ....................................................................55
  Add a Clip to the Workspace ................................................56
  Move a Clip in the Workspace ................................................60
  Select Clips in the Workspace ................................................60
  Cut/Copy/Paste a Clip in the Workspace ................................60
  Align Clips in the Timeline .....................................................61
  Remove a Clip from the Workspace .........................................62
  Replace an Effect in the Timeline .............................................62
Set Chapters ..............................................................................63
Viewing SVRT Information ............................................................64
Preview Your Movie .....................................................................65
  Preview Your Movie in the Preview Window ..........................65
  Preview Your Movie in the Media Viewer ...............................66
Editing Clips ................................................................. 67
  Editing Media Clips ....................................................... 68
    Split a Clip ....................................................... 68
    Trim a Video or Audio Clip ..................................... 69
    Mute an Entire Media Clip ....................................... 73
    Mute an Entire Track ............................................. 73
    Take a Still Snapshot of a Video Clip ....................... 73
    Change the Speed of a Video Clip ............................ 74
    Stretch the Audio Portion of a Video Clip ............... 75
    Change the Color of a Visual Media Clip .................. 75
    Edit an Image Clip in PhotoNow! ............................ 76
    Set a Video Clip’s Interlacing Format ..................... 77
  Change Audio Clip Volume Levels ............................. 78
    Add a Fade Effect to an Audio Clip ........................ 80
    Restore an Audio Clip’s Volume Levels .................... 80
Using Magic Tools .......................................................... 81
  Magic Clean ............................................................ 82
  Magic Motion ........................................................... 85
  Magic Cut ............................................................... 86
  Magic Music ............................................................ 87
Modifying Effects .......................................................... 88
  Set an Effect’s Hold Time ......................................... 88
  Set an Effect’s Duration .......................................... 89
  Modifying a Video Effect ......................................... 91
  Modifying a PiP Effect ............................................. 92
  Modify a Title Effect ............................................ 102
Preview a Clip ............................................................ 109
  Preview Window .................................................... 109
  Media Viewer ......................................................... 111
Contents

Producing Your Movie ................................. 113
  Production Mode ..............................................114
  The Production Wizard ................................. 115
  Produce a Disc ................................................117
  Create a File ..................................................119
    Create an AVI File ........................................119
    Create a DivX File .......................................124
    Create an MPEG-1/MPEG-2 File ..................126
    Create/Modify a Profile ...............................128
  Create a Streaming File ...............................134
    Create a WMV File for Streaming .................134
    Create a RealVideo File for Streaming ..........136
    Create a QuickTime File for Streaming .......139
  Write Back to DV Tape ..................................143
  Burning ......................................................146

Appendix .................................................. 147
  Technical Support ........................................148
    Web Support .............................................148
    Fax Support ..............................................148
    Telephone Support .....................................149
  Hotkeys .....................................................150
  FAQ ................................................................158
  SVRT2: When Can I Use it? ...........................162
  Disc Types & Formats ...................................163
    Disc Types ...............................................163
    Disc Type/Format Compatibility ..................167
  Video Formats & Qualities ............................168
    TV Formats ..............................................168
    Video Qualities .........................................169
  Glossary ......................................................170
  Copyright Notices ........................................175
    Dolby Laboratories ...................................175
    Intel License Agreement For Open Source Computer Vi-
    sion Library .............................................175
Index ............................................................................. 1
Chapter 1:

Introduction

This chapter introduces CyberLink PowerDirector and the digital video editing process. It provides a discussion of the different kinds of technology you will use in the digital movie-making process, as well as system requirements for working smoothly with CyberLink PowerDirector.

This chapter contains the following sections:

- Welcome! on p.2
- The Movie-Making Process on p.3
- Register Your Software on p.5
- Uninstall Your Software on p.6
- The PowerDirector Program on p.7
- System Requirements on p.9
- PowerDirector Versions on p.10
Welcome!

Welcome to the CyberLink family of digital video tools! PowerDirector is a digital video editing program that can help you create professional-looking video movies, complete with music, voice-over, special effects, and transition effects.

If you don’t have experience making movies, don’t worry. CyberLink PowerDirector provides home users with a simple tool to help them do something a little more creative with their home videos. You don’t have to be a video professional or have aspirations of a box office hit to enjoy using PowerDirector.

Where to Begin Reading

Of course, we recommend that you read through the entire User’s Guide for complete information on working with CyberLink PowerDirector. However, some people like to jump in and get working on specific projects. If you are one of those people, please refer to the list below for the page numbers of the information you are looking for.

- If you have questions about the program or the digital movie-making process, start by reading the Introduction on p.1, then check out some of the information in the Appendix on p.147 (in particular, the FAQ on p.158).
- If you want to capture media, read Capturing Media on p.11.
- If you want information on using project files and putting your media clips together into a story, start by reading Creating Your Story on p.37.
- If you want to modify your media clips, read Editing Media Clips on p.68.
- If you want to create a disc, read Produce a Disc on p.117.
The Movie-Making Process

The digital movie production process involves a combination of artistry and technology, beginning with raw video footage and ending with a movie production. CyberLink PowerDirector provides the easiest way to produce your finished movie and publish it to the medium of your choice.

Pre-Production

Before you edit your movie using CyberLink PowerDirector, you must first create (or gather) its component parts: video clips, photos, music, and narrative voice-overs.

If you collect raw footage yourself with a camcorder or other recording device, you can capture that content in PowerDirector’s Capture mode. PowerDirector has functions for capturing from a DV camcorder, TV, webcam, microphone, or Audio CD. If you want to use files that are already on your computer, simply import them into the Library. However you collect your content, you should have all of the bits and pieces of your movie on hand so that the video editing process goes as smoothly as possible.

Putting Your Story Together

Once you have your raw footage on hand, import it into the workspace in PowerDirector’s Edit mode. The workspace offers both timeline and storyboard views to suit your preferred working method. Add and rearrange clips in the workspace - even lock tracks to avoid making mistakes while you work.
Editing

CyberLink PowerDirector’s Edit mode offers loads of options for editing audio, video, and image files in addition to video transitions, video effects, titles, and PiP effects. You might expect to use the functions in PowerDirector’s Edit mode to perform the following tasks:

1. Condense a long video clip to a desired duration using Magic Cut.
2. Clean up audio, video, and image files using Magic Clean.
3. Add a special effect to a video clip.
5. Adjust the sharpness, contrast, and color of a video clip.
6. Mix your background and voice-over tracks.
7. Add transition effects between video clips.
8. Add a pan or zoom effect to an image using Magic Motion.
10. Preview your production.

Producing and Burning Your Movie

After editing your media and creating your movie, it’s time to produce your project. You can choose to make a disc (then proceed to burn it in CyberLink’s PowerProducer), create a movie file for playback on your computer, create a streaming file for use on the Internet, or write your movie back to DV tape.
Register Your Software

After you install the program, a registration window opens, prompting you to register your product. It is important to register your software in order to receive technical support or other information from CyberLink.

To register your software, do this:

1. Enter your personal information in the **First Name**, **Last Name**, and **Email** entry boxes.
   - Check one or both of the options to receive information from CyberLink, or uncheck if you do not wish to receive this information.

2. Click **Register Now**.
   - If you have previously registered this product, click **I Have Already Registered**. The registration box will no longer open when you run the program.
   - If you would like to register this product at a later time, click **Remind Me Later**. The registration box will open each time you run the program until you register.
Uninstall Your Software

If you need to uninstall your CyberLink software for any reason, you can do so either from the Windows Start menu or from the Windows Control Panel.

Uninstall from the Start Menu

To uninstall your CyberLink software from the Start menu, do this:

1. Click Start > Programs > [name of CyberLink software package] > Uninstall [product name]. The uninstall wizard opens.
2. Follow the uninstall wizard to remove the program.

Uninstall from the Control Panel

To uninstall your CyberLink software from the Control Panel, do this:

1. Click Start > Settings > Control Panel.
2. Double-click Add or Remove Programs.
3. Select the program name, then click Change/Remove.
4. Follow the uninstall wizard to remove the program.
The PowerDirector Program

When you first open PowerDirector, the program appears as follows:

- **Edit function buttons**
  - Open editing rooms dedicated to a specific task

- **Mode buttons**
  - Click to switch working modes

- **Library**
  - Contains media clips as well as the various effect and media 'rooms'

- **Preview window**
  - Provides playback controls to preview clips and movies

- **Magic Tools**
  - Provide easy ways to work with media clips

- **Media tracks**
  - Insert media clips here

- **Function buttons**
  - Provide shortcuts to common functions
PowerDirector Modes

PowerDirector has separate modes that enable you to perform different tasks: Capture, Edit, and Produce.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capture</td>
<td>Click to switch to the capture interface. See Capturing Media on p.11.</td>
</tr>
<tr>
<td>Edit</td>
<td>Click to switch to the editing interface. See Editing Clips on p.67.</td>
</tr>
<tr>
<td>Produce</td>
<td>Click to switch to the production interface, which opens the Disc Wizard. See Producing Your Movie on p.113.</td>
</tr>
</tbody>
</table>

By default, the program opens in Edit mode. However, the PowerDirector program changes appearance depending on mode. In addition, certain parts of the program may change within a specific mode. For example, the Library changes display when you click an editing function button, and the workspace can toggle between Timeline and Storyboard views. The different modes and the varying appearances they bring to the PowerDirector program are all described in the sections that follow.

PowerDirector Projects

Changes you make to your video clips, audio files, or photos in CyberLink PowerDirector do not affect your original media. Since your settings are all saved in the project file, you can trim, edit, or delete clips in PowerDirector, but still keep your original files on your hard drive, untouched. So let yourself get creative! If you end up changing things too drastically, you can always start over.

You can open and save a PowerDirector project file just like any other file in Windows. You can also create a new file or save the current file under a different file name.
System Requirements

The system requirements listed below are recommended as minimums for general digital video production work.

Screen Resolution:

- 1024 x 768, 16-bit color or higher

OS:

- Windows XP/2000

Memory:

- 128 MB required (256+ MB DDR recommended)

CPU:

- Capture/produce AVI: Pentium 2-450 MHz or AMD Athlon 500 MHz
- Capture/produce VCD Quality (MPEG-1): Pentium 3-600 MHz or AMD Athlon 700 MHz
- Capture/produce DVD Quality (MPEG-2): Pentium 4-2.0 GHz or AMD Athlon XP 2000+
- Capture/produce High Quality MPEG-4 and Streaming (WMV, QuickTime, RealVideo, DivX): Pentium 4 2.4 Ghz or AMD Athlon XP 2400+
- PowerDirector 4 is optimized for CPU with MMX/SSE/SSE2/3DNow!/3DNow! Extension/HyperThreading technology

Video Capturing Device:

- PCI or USB1.0/2.0 capture device compliant with WDM standard (i.e. PC Camera and TV tuner with WDM driver)
- DV camcorder connected via OHCI-compliant IEEE1394
- Sony MicroMV camcorder
- JVC Everio camcorder (GZ-MC100, GZ-MC200)
Hard Disk Space:
  - 800MB minimum (400MB for Magic Music)
  - 2 GB (4 GB recommended) required for VCD/SVCD production
  - 10 GB (15 GB recommended) required for DVD production

CD/DVD Burning Device:
  - CD/DVD burner (CD-R/RW, DVD+R/RW or DVD-VR/RW) is required to burn VCD/DVD/SVCD titles

Microphone:
  - A microphone is required for recording voice-overs.

PowerDirector Versions

PowerDirector is available in many different OEM versions and the full retail version. File format support, editing features, disc-making functions, and other features vary depending on the version that you have. For information on the availability of specific functions in the PowerDirector version that you are using, please check the PowerDirector Readme file.
Chapter 2:

Capturing Media

This chapter explains how to acquire media for use in CyberLink PowerDirector. You can acquire video and audio from a wide variety of sources, including a webcam, camcorder, TV, VCR, microphone, and audio CD.

This chapter contains the following sections:

- Capture Preferences on p.13
- Capture Options on p.14
- Capture from DV Camcorder on p.21
- Capture from TV on p.30
- Capture from Webcam on p.32
- Capture from Microphone on p.33
- Rip Audio Tracks from CD on p.34
- Record a Voice-Over on p.35
Capture Mode

When you click the button, PowerDirector enters Capture mode, in which you can capture media from a variety of capture devices. In Capture mode, the program appears as follows:

- **Capture preview window**: Displays media clips during capture.
- **Captured Clips area**: Displays media clips after capture.
- **Capture device selection area**: Allows you to switch capture devices and set capture limits.
- **Information display area**: Displays information about captured file size and available HDD space.
Capture Preferences

Before you begin to capture, make sure your capture environment is set according to your preferred working methods.

To set your capture preferences, click Edit > Preferences. The Preferences dialog box opens. Available options are as follows:

- **Add captured files to Library**: Check this option to import captured files into the Library after capture.
- **Add captured files to workspace**: Check this option to import captured files into the workspace after capture.
- **Use video overlay for capture**: Keep this option checked during capture unless you have an older VGA card that does not support video overlay. (Unchecking this option in this event avoids the unsupported overlay display error.)
- **Enable automatic file replacement during voice-over**: Check this option to overwrite existing audio if the voice-over overlaps during recording.
- **Do not detect scenes during capture**: Check this option if you do not want to activate the scene detection function during capture.
- **After capture, detect scenes by changing of video frames**: Check this option to perform scene detection during video capture. In scene detection, PowerDirector compares captured frames to decide when there is a scene change. Each scene is saved as a file as recording continues.
- **During capture, detect scenes by timecode, and save each scene as a separate file (DV-VCR mode only)**: Check this option to detect scene-break signals and to save each scene as a separate file. (DV camcorder generate a scene-break signal on the tape whenever users release the REC button.) This feature is only available in DV tape capture.
- **DV Parameters button**: Click this button to set the buffer parameters for your DV camcorder. Setting a buffer time ensures that your DV camcorder and your batch capture or DV writing device begin at the same time. Without a buffer, batch capturing or writing to tape may begin before the camcorder is engaged.
Capture Options

Many of the options for capturing are shared by different capture modes. These options are described below. Not all of the options described in this section are available in all capture modes. Descriptions of options specific to a single capture mode are found in the section that describes that mode.

Note: PowerDirector’s capture functions vary, depending on version. For information on the availability of specific features in the PowerDirector version that you are using, please check the Readme file.

Capture Limit Options

You can set limits on the size or duration of video that PowerDirector captures. When the limit you set is reached, capture automatically stops.

To set a maximum capture length, check Time limit, then enter a time in the timecode box.

To set a maximum captured file size, check Size limit, then enter a size limit (in MB).
Profile Options

Click Profile. The Profile Setup dialog box opens.

**Note:** For information on selecting a profile, see Create/Modify a Profile on p.128.

- Click the **Comments** and **Details** buttons for more information about the profile.
**Analog Video Capture Options**

Click **Video**. The Analog Video Settings dialog box opens, displaying the Video Setup tab. You may select your capture source here.

Click the Video Adjustment tab and set the video options, if necessary.

Click the TV Setup tab and set the TV options, if necessary.
Audio Capture Options

Before you capture from microphone, there are several options you can set.

Drag the volume level slider to set the input volume level.

Check **Begin with fade-in** to start an audio capture in with a fade-in from silence.

Check **End with fade-out** to end an audio capture with a fade-out to silence.

Click **Audio**. The Audio Setup dialog box opens. You may select your audio input device, audio input source, and input volume here.
Webcam Video Capture Options

When capturing from a webcam, click **Video** to set up your webcam capture profile. Under the Video Setup tab, you can select your capture source. Click **Advanced Settings** for more options.

Click the Video Adjustment tab and drag the sliders to increase or decrease the intensity of the video attributes here.

- Click **Revert** to clear the changes you have just made.
- Click **Default** to reset the attributes to their original levels.
CD/Microphone Capture Profile Setup

When recording from CD or microphone, click **Profile** to set up your CD or microphone recording profile. You may select an audio quality here.

- You can save a profile using a unique name by clicking the **Save As...** button. Click **Remove** to remove the new profiles you create.

Captured Clip Options

After you capture clips, a number of options are available for managing them. Some of these options appear in the dialog box immediately after capture, while others are available in the Captured Clips area of the Capture window.

Click **Change Folder** to set a different destination folder for captured clips.

**Note:** Set this option **before** capturing clips.

Post-Capture Options

To delete a captured file, click **Delete** in the dialog box that appears after recording.

To name a captured file, enter a name in the dialog box that appears after recording. To use default names for captured files, check the **Don’t ask me to rename files again** option in the dialog box that appears after recording.
Captured Clips Area Options

Captured clips appear in the Captured Clips area. Right-clicking clips in this area displays a menu that provides several options:

- **Delete from Disk**: Select this option to remove the clip from the Detected Scenes area and delete the source file from your hard disk.
- **Remove Item**: Select this option to remove the clip from the Detected Scenes area.
- **Play in Media Viewer**: Select this option to view the clip in the Media Viewer. See Preview a Clip in the Media Viewer on p.112.
- **Detect Scenes**: Select this option to detect the scenes contained in a video clip. See Burning on p.146.
Capture from DV Camcorder

DV camcorders are popular among video hobbyists, as they record in a digital format that does not require conversion before being used on a computer, and often provide a number of advanced recording options. You can capture a single scene or a number of scenes in a batch from your camcorder. Procedures for both methods are described below.

Capture a Single Scene

You can capture a single segment of video from your camcorder. This function is particularly useful, for example, if you want to acquire a long video segment in its entirety without skipping over sections.

To capture a single scene from a DV camcorder, do this:

**Note:** Make sure your camcorder is in VRC mode before capturing.

1. Click to open Capture mode.
2. Click to open the DV camcorder capture function. (You may have to wait a few moments as PowerDirector switches devices.)
3. Locate the position at which you would like to begin capturing. You may do this in one of the following ways:
   • Use the playback buttons.
   • Drag the time slider.
   • Enter a timecode, then click to seek to that timecode.

   • Check **Non-realtime** to continue processing captured video after the original video stops playing in order to ensure that no frames are dropped. Capturing video at a higher speed reduces processing time, but yields video of a lower quality. Capturing better quality video requires more CPU power and more time to complete.

5. Click to begin capture. The video plays in the preview window as you capture.
   • Click to stop capture before completion.

6. Enter a name in the dialog box that appears. The clips you have captured appear in the Captured Clips area.
### Batch Capture

Batch capturing may seem intimidating, but in reality, it is an incredibly convenient method of capturing multiple video clips automatically. If you take a few minutes to familiarize yourself with batch capturing, you will save yourself loads more time when you capture video from your camcorder. PowerDirector scans your DV for intervals (or allows you to set them manually), then captures them in a batch using the intervals you created.

#### Automatic Batch Capture

Automatic batch capture is a quick way to capture scenes from a video tape.

To perform an automatic batch capture, do this:

**Note:** Make sure your camcorder is in VRC mode before capturing.

1. Click ![Capture] to open Capture mode.
2. Click ![DV device capture function] to open the DV device capture function. (You may have to wait a few moments as PowerDirector switches devices.)
   - Check **Non-realtime** to continue processing captured video after the original video stops playing in order to ensure that no frames are dropped.

4. Click ![DV QuickScan](image). The DV QuickScan dialog box opens.

   ![DV QuickScan](image)

   - Click **Note** for important information on how to use the DV QuickScan function.

5. Locate the position at which you would like to begin scanning for intervals. You may do this in one of the following ways:
   - Use the playback buttons.
   - Drag the time slider.
   - Enter a timecode, then click ![Seek](image) to seek to that timecode.

6. Click **Start** to start scanning for intervals. PowerDirector scans for intervals.
7. Click **Stop** after all of the video segments you want to capture have been scanned. Scanned intervals appear as thumbnails in the window.

8. Check the thumbnails of the intervals you want to batch capture.
   - You can change the profile of the clips to be captured. To do this, click **Profile** and select a new profile.
   - To combine sequential intervals into a single interval, check the intervals, then click **Merge**. Click **Auto-Merge** to combine intervals to combine all checked intervals in sequence or to merge all of the clips in an interval that you can set.

9. Click **Start** to begin batch capture. PowerDirector rewinds your tape to the position of first clip, then begins capturing all of the intervals you have checked. The video plays in the preview window as you capture. The clips you have captured appear in the Captured Clips area.
• Click **Stop** to if you want to stop the capture process.

10. Click **Finished** to return to Capture mode.
Manual Batch Capture

Using manual batch capture gives you more control over the capturing process and ensures that the scenes you want to include are captured. Manual batch capturing is recommended when you are sure which scenes you want to capture and have a good idea where they are located on the tape.

To perform a manual batch capture, do this:

**Note:** Make sure your camcorder is in VRC mode before capturing.

1. Click \[\text{Capture}\] to open Capture mode.

2. Click \[\text{DV device capture}\] to open the DV device capture function. (You may have to wait a few moments as PowerDirector switches devices.)

   - Check **Non-realtime** to continue processing captured video after the original video stops playing in order to ensure that no frames are dropped.
4. Click 🎞️. The DV Manual Scan/Batch Capture dialog box opens.

5. Navigate to the mark in time by doing one of the following:
   - Click inside the timecode box, enter a time using your keyboard, then press the Enter key.
   - Use the playback buttons.

6. Click 🎞️ to set the mark in point.

7. Navigate to the mark out time, then click 🎞️ to set the mark out point. The intervals you set appear in the pane to the right of the preview window.
**Note:** You can continue to set intervals of clips to capture. Each interval, however, must have a duration of at least two frames.

8. Click **Start** to begin batch capture. PowerDirector rewinds your tape to the position of first clip, then begins capturing all of the intervals you have checked. The video plays in the preview window as you capture. The clips you have captured appear in the Captured Clips area.
   - Click **Stop** if you want to stop the capture process.
   - Click **Add** to start another round of batch capturing.

9. Click **Finished** to return to Capture mode.
Capture from TV

You may wish to add segments from your favorite TV programs to your movie production, or simply record other segments for different uses.

To capture from TV, do this:

1. Click to open Capture mode.

2. Click to open the TV capture function. (You may have to wait a few moments as PowerDirector switches devices.)

3. Set your capture options (if necessary).
   - Click if you have CATV, or click if your TV has an antenna.

4. Locate the channel you want to capture. You may do this in one of the following ways:
   - Click to go up a channel or to go down a channel.
   - Click to return to the previous channel.
   - Enter a channel number in the channel box.
5. Click 🔴 to begin capture.

6. Click ⏹️ to stop capture.

7. Enter a name in the dialog box that appears. The clips you have captured appear in the Captured Clips area.
Capture from Webcam

Webcams (also known as PC cameras) are inexpensive, handy video cameras that you can use for simple video capturing.

To capture from webcam, do this:

1. Click to open Capture mode.

2. Click to open the webcam capture function. (You may have to wait a few moments as PowerDirector switches devices.)


4. Click to begin capture.

5. Click to stop capture.

6. The clips you capture appear in the Captured Clips area.
Capture from Microphone

Your movie may require a narrative voice-over, or you may elect to record dialog in a studio for better acoustics. No matter what kind of audio tracks you record, they can be captured with a microphone for use in your PowerDirector project.

To capture from microphone, do this:

1. Click \[\text{Capture}\] to open Capture mode.

2. Click \[\text{Microphone}\] to open the microphone capture function. (You may have to wait a few moments as PowerDirector switches devices.)

   - Click \[\text{Fade In}\] to add a fade-in effect.
   - Click \[\text{Fade Out}\] to add a fade-out effect.

4. Set your master audio level. To do this, click \[\text{Audio}\], then drag the slider to the desired recording level. (You may also adjust audio levels on the fly while recording.)

5. Click \[\text{Capture}\] to begin capture. Recording begins after a three-second countdown.

6. Click \[\text{Stop}\] to stop capture.
Rip Audio Tracks from CD

Using your favorite music can help you to create a really fun, personalized movie. If you have music stored on an audio CD, you can rip the songs you want and then add them as audio tracks in PowerDirector.

To rip audio tracks from CD, do this:

1. Click to open Capture mode.

2. Click to open the CD capture function. (You may have to wait a few moments as PowerDirector switches devices.)

3. Select a drive.

4. Select the track you want to rip.


6. Click to begin capture.

   • Click to stop capture.

7. Enter a file name for the captured file and click OK.
Record a Voice-Over

The Voice-Over Recording Room contains controls for recording a narration from a microphone while watching the video clip the voice-over is destined to accompany. When you capture your narration, the audio track is synched with the video portion.

To record a voice-over, do this:

1. Click to open the Voice-Over Recording Room.
   - Click to add a fade-in effect.
   - Click to add a fade-out effect.
3. Locate the point in your movie at which you want to begin recording a voice-over. You may do this in one of the following ways:
   - Drag the Timeline slider.
   - Drag the preview window slider.
   - Use the playback buttons.
- Enter a timecode in the timecode box.

4. Drag the Recording volume level slider to set the input volume level.

5. Click to begin recording. Record your voice-over as you watch the video in the preview window.

6. Click to stop recording.

7. Click to close the Voice-Over Recording Room.
Chapter 3: Creating Your Story

This chapter discusses how to work with project files, import media into the Library, and manage clips in both the Library and the workspace. It also describes how to view project information and to preview your movie during production.

This chapter contains the following sections:

- Working with Project Files on p.38
- General Preferences on p.40
- The Library on p.43
- Managing Media in the Library on p.46
- Managing Clips in the Workspace on p.53
- Set Chapters on p.63
- Viewing SVRT Information on p.64
- Preview Your Movie on p.65
Working with Project Files

This section describes working with PowerDirector project files. These are the basic commands for managing new and existing projects.

Create a New Project

To create a new project file, click File > New Project. If an unsaved project file is open in the workspace, you are prompted to save it.

Save a Project

To save the current project file, click File > Save Project. (To save the current project file under a different file name, click File > Save Project As....) In the dialog box that opens, enter a file name and location, then click Save.

Open an Existing Project

To open an existing project file, click File > Open Project.... If an unsaved project file is open in the workspace, you are prompted to save it. In the dialog box that opens, locate the project file you want to work with, then click Open.

New Workspace

To clear the workspace of all clips and effects, click File > New Workspace.
View Project Properties

You can view such project properties as the creation date, the author's name, associated keywords, etc.

To view project properties, click File > Project Properties....
General Preferences

CyberLink PowerDirector offers a range of choices to set your video production environment to better suit the way you work.

File Preferences

To set your file preferences, click Edit > Preferences... The Preferences dialog box opens, displaying the File tab. Available options are as follows:

- **Import directory**: Set the folder where PowerDirector looks by default for media clips when you load media files. To change this folder, click **Browse** and select a new folder.

- **Export directory**: Set the folder where PowerDirector saves captured media files by default. To change this folder, click **Browse** and select a new folder.

- **Captured video prefix**: Enter a default name for captured video files. PowerDirector automatically appends a sequential number to this name to create a unique filename for each captured file. **Always prompt me to confirm filename**: Check this option if you would like PowerDirector to prompt you to enter a filename each time you capture video.

- **Production file prefix**: Enter a default name for files produced in PowerDirector.

- **Snapshot filename**: Enter a default name for snapshot captures. PowerDirector automatically appends a sequential number to this name to create a unique filename for each captured file. Select a file format from the drop-down list. **Always prompt me to confirm filename**: Check this option if you would like PowerDirector to prompt you to enter a filename each time you take a snapshot.

- **Snapshot destination**: Select a destination for snapshot captures from the drop-down list.
• **Recently used file list**: Enter a number (between 0 and 20) of recently used files that you would like to make available in the File menu when you open PowerDirector.

• **Automatically load the most recent project when PowerDirector opens**: Check this option to load the project you have been working on most recently whenever you open PowerDirector.

### General Preferences

To set your general preferences, click **Edit > Preferences**... The Preferences dialog box opens. Click the General tab. Available options are as follows:

• **Undo levels**: Enter a number (between 0 and 100) of levels of undo you would like to make available while you work on your movie production. Setting a higher number of undo consumes more CPU resources.

• **TV format**: Select the TV format (NTSC or PAL) of the region in which you would like to produce your movie. This format should correspond to the format of the region in which you plan to play your movie (if you burn it to disc).

• **Default workspace**: Select to open the Timeline or Storyboard workspace in PowerDirector by default.

• **Preview during production**: Check to enable the video preview window during production. Uncheck to disable the preview window during production and reduce production time.

• **Link objects across tracks when moving/deleting content in Video track**: links title, effect, music, and PiP clips to clips in the Video track. Checking this option moves these other clips when a clip in the Video track moves. Unchecking this option treats Timeline tracks separately and does not bind other tracks to the Video track.

• **Add crossfade between photos when applying Magic Motion**: Adds a crossfade effect between adjacent photos when you use the Magic Motion tool.
• **Durations**: Set default durations (in seconds) for image files and the different effects in the timeline.

• **Always prompt me when TV format conflicts**: Check this option to enable a warning message when you add a video clip to the workspace whose TV format (NTSC/PAL) conflicts with that of the video clips already located in the workspace.

• **Enable file deletion from hard drive and ask me for confirmation**: Check this option if you would like to be able to delete files located on your hard drive using a menu option in the Library.

• **Enable warning when chapters are removed during editing**: Displays a warning message that chapter points have been deleted during video editing.
The Library

The Library is the storeroom in which all of the media clips used in your projects are kept. In addition, the Library displays all of the different types of effects that can be applied to media clips. The Library appears as follows:

Which contents the Library displays depends on the edit function button you click. These buttons are shown below:

Each of these buttons opens an editing ‘room’ dedicated to a specific task. By default, the Library opens to the Media Room. However, the Library retains the same buttons and functions in each of these views.
Media Room

The Media Room is the storage area for the media that you will use in your video editing project. Which type of media clips appear in the Media Room depends on the selection you make in the Filter drop-down list. For more information, see Load Clips into the Library on p.46 and Add a Clip to the Workspace on p.56.

Effect Room

The Effect Room contains all of the special effects that can be applied to video or image clips in the workspace. For more information, see Add a Video Effect on p.58.

Title Room

The Title Room contains all of the title effects that can be applied to the workspace. For more information, see Add a Title Effect on p.59.

Transition Room

The Transition Room contains all of the transition effects that can be applied between video or image clips in the workspace. For more information, see Add a Transition Effect on p.59.

Audio Mixing Room

The Audio Mixing Room contains audio mixing controls for the different audio tracks in the workspace. For more information, see Mix Audio Levels in the Audio Mixing Room on p.79.
Voice-Over Recording Room

The Voice-Over Recording Room contains controls for recording a narration from a microphone while watching the video clip the voice-over is destined to accompany. For more information, see Record a Voice-Over on p.35.

Chapter Setting Room

The Chapter Setting Room contains options for automatically or manually setting chapter markers. Setting chapters on your final disc allows viewers to jump from the menu page to the chapter markers you have set in order to navigate around your disc. For more information, see Set Chapters on p.63.
Managing Media in the Library

After you have obtained the media files you want to work with, the next step is to add them into the Library (where they become media “clips”) in order to make them available for your movie. Once your clips are loaded, you can change the display of your media clips in the Library and delete unnecessary clips.

Load Clips into the Library

When loading media clips into PowerDirector’s Library, you have two options: to load media files individually, or to load an entire folder that contains media files you want to use in your current project.

Note: PowerDirector's file format support varies, depending on version. For information on the availability of specific features in the PowerDirector version that you are using, please check the Readme file.

Load Individual Media Files

To specify individual media files to load into the Library, do this:

1. Click \(\text{\text{Media Room}}\) to open the Media Room.
2. Select the type of media you want to load (or All Media) from the Filter drop-down list.

Note: By selecting a media type (other than All Media) in this drop-down list, you restrict the type of media displayed in the Library, and consequently, the type of media that you can import.

3. Click \(\text{\text{Load Media File(s)}}\) and select Load Media File(s). A dialog box opens.
4. Locate and open the file(s) you want to add. Thumbnails of each of the media files you have selected appear in the Library.
Load a Media Folder

To load all of the media files in a particular folder, do this:

1. Click to open the Media Room.
2. Click and select Load a Media Folder. A dialog box opens.
3. Locate the folder you want to open, then click OK. All of the media files in that folder are loaded into the Library.

Sort Clips in the Library

Once your media clips are loaded into the Library, you can restrict the display to a certain type of media for a simpler view, and you can also sort media files using different criteria.

- Select the type of media you want to view (or All Media) from the Filter drop-down list. Only those clips that belong to the media type you have selected are displayed in the Media Room.
- To change the way media files are sorted, click . Select Sort by, then choose a sorting option (Name, Duration, File size, Date, Type).

Note: Color boards can be sorted by Name, R (Red), G (Green), and B (Blue), or Date.

- To change the way media files are displayed, click . Select Display by, then choose a display option (Thumbnails or Details).
Remove a Clip from the Library

To remove a media clip from the Library, do this:

1. Click \(\text{Icon} \) to open the Media Room.
2. Select the clip(s) you want to remove, then do one of the following:
   - Press the **Delete** key.
   - Click \(\text{Icon} \) and select **Delete selected**.
   - Right-click the clip(s), then select **Remove from Library** or **Delete from disk**.

**Note:** The **Remove from Library** option makes the clip unavailable in the Library but does not affect the original media file on your hard disk. The **Delete from Disk** option both removes the clip from the Library and deletes the original file on your hard disk.
Rename a Clip in the Library

Clips you import into the Library retain their original file names, which are often non descriptive and difficult to use in a video editing project. By using an alias, you can rename any clip in the Library to better suit your project. (For example, you may wish to use the alias “first video clip” instead of “video_005.mpg.”)

To rename a clip using an alias, do this:

1. Right-click the clip you want to rename and select **Use alias**.
2. Enter a name and press Enter on your keyboard or click outside the name box. The clip appears in the Library using the alias.

Restore a Clip’s Original File Name

Although using an alias is handy while working on your video project, you may find it necessary to view the original name of the clip (for example to verify which version of a clip you are using).

To restore a clip’s original name, right-click the clip you want to rename and select **Restore original clip name**. The clip now appears in the Library using the original clip name.
View Clip Properties

If you need to view information about a media clip in the Library or the workspace (such as its format, file path, size, frame rate, etc.), you can view the clip’s properties.

To view clip properties, right-click the clip and select Properties. The Properties dialog box opens.

![Properties dialog box](image)
Detect Scenes in a Video Clip

The scene detection function automatically creates individual clips based on the individual scenes contained within a video clip. Detected scenes are not split from the original clip, but can be added to the workspace like any other media clip. Likewise, they may also be merged together or removed entirely without changing the original video clip.

To detect scenes in a video clip in the Library, do this:

1. Select the video clip whose scenes you want to detect.
2. Click . The Scene Detection window opens.
3. Increase or decrease scene detection sensitivity, if necessary. Increased or decreased scene detection sensitivity yields an increased or decreased number of scenes that are detected. You may do this in one of the following ways:
   - Drag the Sensitivity slider.
   - Click the or buttons.
4. Click Settings and set your scene detection options, if necessary:
   - The Detection Method section pertains to video clips that have been captured. (If the video clip was not captured, the Detection Method options are disabled.) If you have a DV AVI clip that contains multiple time codes (i.e.: time codes are automatically set when you start and stop recording) and you wish to split up your clip in this manner, select Detect by
changing of timecodes. Otherwise, use Detect by changing of video frames.

5. Locate the position at which you would like to begin detecting scenes. You may do this in one of the following ways:
   - Use the playback buttons.
   - Drag the time slider.
   - Enter a timecode.

6. Click Detect. The video clip plays in the Preview Window from the point you have set.
   - To set scenes manually, click Split instead of Detect.
   - To stop the scene detection process before completion, click Stop or press the <Esc> key.
   - After the original scene detection, you may further detect scenes within a newly generated scene. To detect scenes manually (including changing detection sensitivity), select a scene, then repeat the steps for detecting scenes. To detect scenes automatically, right-click a scene and select Detect again from this scene.
   - To remove a scene after detection, right-click the scene and select Remove scene.

7. Click OK to close the Scene Detection window.
   - To return to the Library, click Up One Level.

Clips created by the new scenes are displayed in a subfolder under the original video clip. They can be added to the workspace and managed in the Library like any other video clip.

Video clips that contain detected scenes show a small folder icon in the lower right-hand corner of the clip when displayed in the Library. To display a clip’s scenes, click the folder icon.
Managing Clips in the Workspace

The edit interface consists of a workspace to which you can add clips. You can set which view opens by default in the Preferences dialog box. You can also switch views by clicking the Timeline or Storyboard buttons. You can load media and effect clips into specific tracks in the workspace, move them to different locations in your story, and delete them from the workspace. This section describes how to add clips to the proper track and how to manage clips once they have been added.

Timeline View

When you first open PowerDirector, the program opens to the Edit interface in whichever mode you have set in your preferences.

To switch to Timeline view, click .
Media Tracks

The Timeline contains the following tracks:

<table>
<thead>
<tr>
<th>Track</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video</td>
<td>Contains your movie’s main video and/or image clips.</td>
</tr>
<tr>
<td>Effect</td>
<td>Contains special effects that apply to the video or image clip in the Video track at the same location.</td>
</tr>
<tr>
<td>PiP</td>
<td>Contains video/image clips, which are overlaid on any clip in the Video track that appears during the PiP effect’s duration.</td>
</tr>
<tr>
<td>Title</td>
<td>Contains title effects that appear over any clips in the Video track that occur during the title effect’s duration.</td>
</tr>
<tr>
<td>Voice</td>
<td>Contains a narrative voice-over or second audio clip.</td>
</tr>
<tr>
<td>Music</td>
<td>Contains your movie’s main audio clip.</td>
</tr>
</tbody>
</table>

Locking/Unlocking Tracks in the Timeline

To lock a track in the Timeline, click 🗝 at the extreme left of the track. When a track is locked, you cannot add new clips to the track, nor move or edit the clips it contains. To unlock a track in the Timeline, click 🗝 at the extreme left of the track. When a track is unlocked, you can freely add, move, and edit clips. For more information, see Move a Clip in the Workspace on p.60.

Resizing the Ruler

You can resize the ruler for a more expanded or more condensed view of your production. To resize the ruler, click inside the ruler and drag. Expand the ruler for more a precise view, which is especially handy when aligning clips and effects, or condense the ruler for a global overview of your entire production.
Storyboard View

You can switch to Storyboard view while editing your movie for a simpler view of the clips that your movie contains.

To switch to storyboard view, click .
Add a Clip to the Workspace

The different types of clips may only be added to specific tracks. The sections below describe the procedures for adding each kind of media clip into the workspace.

**Note:** You may prefer to add clips in Storyboard view, since this view is simpler than the Timeline view. However, clips can only be added to the Video track in this view. Therefore, this section uses the Timeline view in all of the procedures.

Add Video & Image Clips

You can add video and image clips to either the Video track or the PiP (picture-in-picture) track. To create the basic framework of your movie, add video and image clips to the Video track. Add clips to the PiP track only to create a picture-in-picture effect.

To add video or image clips to the workspace, do this:

1. Click to open the Media Room.
2. Select **Video**, **Image**, or **All Media** from the Filter drop-down list to sort the clips in the Media Room.
3. Select a clip, then add it to the workspace. You may do this in one of the following ways:
   - Click to add the clip to the Video track or to add the clip to the PiP track.
   - Drag clips to a desired position in the Video or PiP track. When adding clips to the Video track, you cannot leave an empty gap between the last clip and the new clips you are adding. Clips added to the end of the Video track follow immediately after the final clip in that track.

**Note:** You may select several clips and drag them together into the same track, provided all of the clips are compatible with the destination track.
Add Color Boards

Using color boards allows you to insert solid frames of color into your movie. You might, for example, want to fade in to or out from a certain color, or add a solid background to a picture-in-picture effect.

Color boards are not media files as such, but they can be applied to the workspace and managed in the Library just like video and image clips. You can add color boards to either the Video or the PiP track.

To add a color board to the workspace, do this:

1. Click \( \text{[image]} \) to open the Media Room.
2. Select Color boards from the Filter drop-down list. The current color boards appear in the Library.
3. Select a color board, then add it to the workspace. You may do this in one of the following ways:
   - Click \( \text{[image]} \) to add the color board to the Video track or \( \text{[image]} \) to add the color board to the PiP track.
   - Drag one or more color boards to a desired position in the Video or PiP track. When adding clips to the Video track, you cannot leave an empty gap between the last clip and the new clips you are adding. Clips added to the end of the Video track follow immediately after the final clip in that track.
Add Audio Clips

Using audio clips allows you to add background music or a narrative voice-over to your movie. PowerDirector provides two tracks for audio media (the Music and Voice tracks), which you can use interchangeably.

**Note:** Audio files can only be added to the workspace in Timeline view. If you drag an audio file to the workspace in Storyboard view, the workspace automatically switches to Timeline view.

To add an audio clip to the workspace, do this:

1. Click \( \text{ } \) to open the Media Room.
2. Select **Audio** or **All Media** from the Filter drop-down list.
3. Select an audio clip, then add it to the workspace. You may do this in one of the following ways:
   - Click \( \text{ } \) to add the audio clip to the Voice track or \( \text{ } \) to add the audio clip to the Music track.
   - Drag one or more audio clips to a desired position in the Voice or Music track. Audio clips can be added at any point in this track.

Add a Video Effect

The procedure below describes how to add a video effect to the Timeline.

To add a video effect to the Timeline, do this:

1. Click the \( \text{ } \) button to open the Effects Room.
2. Drag an effect from the Effects Room into the Effect track directly beneath the clip(s) in the Video track that you want to affect.
   - You may click \( \text{ } \) to add the effect to the Effect track at the current position of the Timeline slider.
   - You can randomly add an effect at the current position of the Timeline slider. Click \( \text{ } \), then select the random option.
Add a Title Effect

The procedure below describes how to add a title effect to the Timeline.

To add a title effect to the Timeline, do this:

1. Click to open the Title Room.
2. Drag an effect from the Title Room into the desired position in the Title track.
   - When a title effect is selected, you may click the button located below the Library to add the effect to the Title track at the current position of the Timeline slider.
   - You can randomly add an effect at the current position of the Timeline slider. Click , then select the random option.
3. Edit the title effect in the Title Designer that opens. See Modify a Title Effect on p.102.

Add a Transition Effect

The procedure below describes how to add a transition effect to the Timeline.

To add a transition effect to the Timeline, do this:

1. Click to open the Title Room.
2. Drag an effect from the Transition Room between the clip(s) in the Video track that you want to affect.
   - You can randomly add an effect at the current position of the Timeline slider. Click , then select the random option.
   Transition effects are randomly applied between all of the clips currently in the Timeline.
Move a Clip in the Workspace

Once a clip has been added to the workspace, you can drag it to a different location on the track it is currently located in. (Only audio clips can be dragged between tracks.) You may find moving media clips easier in Storyboard view, especially if the clip has an extremely short duration, or if you need to move it a relatively long distance over the workspace.

**Note:** Moving a clip in the Video track automatically adjusts the duration of the effects applied to it to synchronize with the remaining clips in the Video track. Some effects may therefore disappear or change length when you move a clip.

Select Clips in the Workspace

To select clips in the workspace, do one of the following:

- To select clips in a series, press the Shift key, then select the clips.
- To select multiple, non-contiguous clips, press the Ctrl key, then select the clips.
- To select all of the clips in a track, right-click inside the track, then select Select All.

Cut/Copy/Paste a Clip in the Workspace

You can cut, copy, and paste media clips in PowerDirector’s workspace.

When you paste, clips appear at the current position of the Timeline slider. If that position occurs within the duration of a media clip, the new clip is pasted immediately after that clip. If the Timeline slider is positioned in a gap between clips, the new clip is pasted and truncated (if necessary) to fit in the gap (PiP/Music/Voice tracks only). If the Timeline slider is positioned after the last clip, the new clip is pasted immediately after the last clip.
Align Clips in the Timeline

You can align PiP, effect, and title clips to the edge of the clip above them in the Video track to ensure that their starting and ending times coincide.

To align a clip, right-click it in the timeline, then select **Align to Edge**. The Align to Edge dialog box opens.

The Align Left tab displays options for stretching the clip’s left edge. The following options are available:

- **Extend to the left edge**: Extends the clip to the next available border to the left in the Video track.
- **Shrink to the right edge**: Shrinks the clip to the next available border to the right in the Video track.

The Align Right tab displays options for stretching the clip’s right edge. The following options are available:

- **Extend to the right edge**: Extends the clip to the next available border to the right in the Video track.
- **Shrink to the left edge**: Shrinks the clip to the next available border to the left in the Video track.
Remove a Clip from the Workspace

To remove a clip from the workspace, select the clip(s) you want to remove, then do one of the following:

- Press the Delete key.
- Click the Delete button.
- Right-click the clip, then select Delete.

Replace an Effect in the Timeline

You can replace any effect in the Timeline with a different effect that you select in the Effect Room without having to delete one effect and add another.

To replace an effect in the Timeline, do this:

1. Position the Timeline slider on the effect that you want to replace.

2. Click to open the Effect Room.

3. Right-click a new effect in the Effect Room, then select **Add/Replace in Timeline**. The new effect replaces the effect in the Timeline.
Set Chapters

Chapters allow for ease of navigation on a disc. If you set chapters on your disc, viewers can jump from the menu page to the start of these chapters in order to skip previous content. However, you may choose not to include chapters. If you do not set chapters, your movie plays automatically when the disc is inserted into a player.

To set chapters automatically, do this:

1. Click ☐ to open the Chapter Setting Room in the Library.

2. Set chapter points by doing one of the following:
   - To set a chapter at the beginning of each video clip, click ☐.
   - To set chapters at fixed intervals, enter an interval (in minutes), then click ☐.
   - To specify the number of chapters in your disc, enter the number of chapters in the entry box, then click ☐.
   - To set chapter points manually, navigate to a location on the timeline, then click ☐.
   - Click ☐ to remove a chapter point.
   - Click ☐ to remove all of the chapter points you have set.
Viewing SVRT Information

SVRT (Smart Video Rendering Technology) is a proprietary rendering technology from CyberLink that recognizes which portions of a movie clip have been modified (and therefore require rendering during production), and which portions of a movie clip have not been changed (and thus can be skipped over during rendering). By viewing SVRT information, you can simulate the production process.

**Note:** For more information on SVRT, see SVRT2: When Can I Use it? on p.162.

To view how PowerDirector uses SVRT in your current project, do this:

1. Click **View > SVRT Information**. The SVRT Info Room opens and the SVRT track appears on the timeline.
   
   ![SVRT Info Room](image)

2. Select the profile you want to use to produce your movie, then click **Update SVRT Info** to view updated SVRT information. The colors that appear in the SVRT track designate how PowerDirector uses SVRT for the related clip (or clip portion).
   - **Green:** no rendering is required during production. (This requires the least amount of production time.)
   - **Blue:** only video rendering is required.
   - **Yellow:** only audio rendering is required.
   - **Red:** both audio and video rendering is required. (This requires the greatest amount of production time.)
Preview Your Movie

Before you commit your movie to disc, it’s a good idea to preview it to make sure all of your clips and effects are working to create the movie you want. It is highly recommended that you preview your movie at least once before production so you can solve problems without spending time unnecessarily in production.

Preview Your Movie in the Preview Window

You can preview your movie at any point during the editing process in order to ensure that your editing is going smoothly. Using the Timeline slider, you can preview your movie production from any point within the Timeline.

Note: When previewing clips in the workspace, ensure that the preview window is in Movie mode. If the preview is in Clip mode, click the Movie button before previewing your movie production.

1. Click the Movie button in the preview window.
2. Locate the point at which you want to begin your preview. You may do this in one of the following ways:
   - Drag the Timeline slider.
   - Drag the preview window slider.
   - Enter a timecode in the timecode box.
3. Press Play. The preview starts from the point you have specified.
4. Use the playback buttons to control the preview.
Preview Your Movie in the Media Viewer

To preview your movie in the Media Viewer, do this:

1. Click the Movie button in the preview window.

2. Click . The Media Viewer opens.

   - You may drag an edge or a corner to resize the Media Viewer window.


4. Use the playback buttons to control the preview.
Chapter 4: Editing Clips

This chapter discusses how to load media into the Library for use in your projects, how to add your media clips to the workspace, then how to manipulate and edit media clips once they are loaded into the workspace. Adding and manipulating media clips allows you to construct the framework of your movie production - to lay out and organize the story you want to tell.

This chapter contains the following sections:

- Editing Media Clips on p.68
- Using Magic Tools on p.81
- Modifying Effects on p.88
- Preview a Clip on p.109
Editing Media Clips

‘Editing’ is a broad term that encompasses a number of different functions: you can, for example, trim unwanted sections from video or audio clips, increase or decrease the speed of a video clip, or apply a special effect. This section describes all of the editing processes that you can perform on the different types of media clips.

Note: The functions in this section can only be performed in Timeline view.

Split a Clip

You can split a media clip into two clips at the current position of the Timeline slider. The procedure is the same for any type of clip (media or effect) except for transitions.

To split a media clip, do this:

1. Select the clip you want to modify.
2. Place your cursor at the position at which you want to split the clip.
3. Click Split. The clip is split into two independent clips that can be moved or modified separately in the workspace.

Note: Splitting a video or audio clip does not delete any portion of the content. Both halves of a split video or audio clip can be stretched back to any length up to the original duration.
Trim a Video or Audio Clip

Video clips captured from external capture devices often contain unwanted portions at the beginning, between scenes, or at the end. These unwanted portions can easily be removed in PowerDirector using the Trim function.

Likewise, if you want to tailor your audio clip to fit the duration of a video clip, you can easily trim your audio clip to a desired length.

**Note:** Trimming a video or audio clip does not delete any portion of the content.

Perform a Simple Trim

To trim a video or audio clip, do this:

1. Select the clip you want to modify.
2. Click **Trim**. The Trim option panel opens.
3. Enter a mark in and mark out time. You may do this in one of the following ways:
   - Click inside the timecode box and enter a time using your keyboard.
   - Drag the mark in/mark out sliders to the correct time position.
   - Navigate to the desired time position using the playback buttons.
4. Click the Mark in and Mark out buttons.
5. Click **/>** to close the option panel.
Perform a Multiple Trim

You can trim multiple portions from a video clip, resulting in individual clips, which are independent of the original clip. You can also detect scenes using the Multi Trim tool. Detected scenes, by contrast, are not split from the original clip, but are simply divisions contained within it.

To perform a multiple trim on a video clip, do this:

1. Select the clip you want to modify.
2. Click Multi Trim. The Multi Trim dialog box opens.

3. Navigate to the mark in time by doing one of the following:
   - Click inside the timecode box, enter a time using your keyboard, then press the Enter key.
   - Drag the time slider to the correct time position.
   - Use the playback buttons.

4. Click to set the mark in point.
   - To view the timeline more clearly, click to open the timeline magnifier. Click to zoom in or to zoom out.

5. Navigate to the mark out time, then click to set the mark out point. The scene you set appears in the pane to the right of the preview window.
• To detect scenes automatically, click . For more information, see Detect Scenes in a Video Clip on p.51.
• To remove a scene, click Remove.
• To split a long scene into two shorter scenes, navigate to a position inside a chapter you have already set, then click to split the scene.

**Note:** You can continue to cut multiple scenes from the video clip. Each scene, however, must have a duration of at least two frames.

6. Click OK.

**Trim by Dragging an Edge**

You can trim any kind of media clip in the Timeline (including audio, video, and image clips and color boards) by dragging either edge of that clip. You may find trimming a clip in this way easier if you first expand the ruler.

**Note:** Video and audio clips cannot be lengthened beyond their original duration.

To trim a media clip by dragging an edge, do this:

1. Select the clip you want to modify.
2. Position your cursor at one end of the clip and drag the end of the clip to the new position.

**Note:** You can drag the edge of a clip to lengthen it or to shorten it. If you compress the start of a video or audio clip, playback begins at a later frame within the clip. If you compress the ending, playback ends at an earlier frame within the clip.
Trim a Video Clip Using Precise Cut

If you need to trim video extremely accurately (for example at the frame level), use the Precise Cut feature in the Media Editor window. The Media Editor is a large, resizable preview window that offers a magnified timeline that is particularly useful for accurate trimming of longer videos.

To trim a video clip using Precise Cut in the Media Editor, do this:

1. Select the clip you want to modify.
2. Click Trim.
   - Click Clip on the preview window, if necessary.
3. Click . The Media Editor window opens.

4. Click to enable the Precise Cut magnifier, then click + to zoom the timeline in or - to zoom out.
5. Enter a mark in and mark out time. You may do this in one of the following ways:
   - Click inside the timecode box and enter a time using your keyboard.
   - Drag the mark in/mark out sliders to the correct time position.
   - Use the playback buttons.

   Note: Drag the bottom slider for more precise control.

6. Click the Mark in and Mark out buttons.
7. Click to close the Media Editor window.
Mute an Entire Media Clip

You may wish to mute the audio output of an entire media clip. To do this, right-click the clip and check **Mute Clip**. Any audio volume keys you have added are hidden.

To unmute the track, right-click the track and uncheck **Mute Clip**. The audio volume keys you have added are restored.

Mute an Entire Track

You may wish to mute the audio output of an entire track. To do this, right-click the track and select **Mute Track**. Any audio volume keys you have added are hidden.

To unmute the track, right-click the track and deselect **Mute Track**. The audio volume keys you have added are restored.

Take a Still Snapshot of a Video Clip

You can capture a single frame from a video clip and automatically load the snapshot in the Library.

To take a snapshot of a video clip, do this:

1. Select the clip you want to modify.
2. Click **Trim**.
3. Navigate to the frame you want to capture using the playback buttons.
4. Click **Snapshot**. The frame is captured and stored in the Library as an image file.
Change the Speed of a Video Clip

Slow-motion or fast-motion effects can grab your audience’s attention as well as break up the rhythm of a movie.

**Note:** Video clips can be located in either the Video or PiP track.

To change the speed of a video clip, do this:

1. Select the clip you want to modify.
2. Click **Speed**. The speed option panel opens.

3. Set the new speed (between .5x and 2x). You may do this in one of two ways:
   - Drag the slider to increase or decrease the speed.
   - Enter a timecode in the New video length box. (This method allows more accurate control, as you can specify a length down to the frame level.)
4. Click **Done** to close the option panel.
Stretch the Audio Portion of a Video Clip

When you alter the speed of a video clip, you may wish to stretch the audio portion at the same proportion as the video portion.

To change the speed of a video clip, do this:

1. Select the clip you want to modify.
2. Click **Speed**. The speed option panel opens.
3. Click **Stretch Audio**. This option stretches the video clip’s audio portion (between .5x and 2x). The pitch of the audio portion remains unchanged to avoid unexpected audio results.
4. Click **»** to close the option panel.

Change the Color of a Visual Media Clip

You may wish to change the color attributes of a video or image clip or a color board in order to produce a surprising effect, or simply to emulate reality more closely. Either result is easy to achieve in PowerDirector.

To change the color of a visual media clip, do this:

1. Select the clip you want to modify.
2. Click **Color**. The color option panel opens.

3. Set the color options that you want to apply:
   - **Brightness**: the brightness/darkness of the image
   - **Contrast**: the difference in proportion between lights and darks in the image
   - **Hue**: the individual colors in the image
   - **Saturation**: the depth of the colors in the image
   - **Sharpness**: the clarity of details in the image
4. Click **»** to close the option panel.
Edit an Image Clip in PhotoNow!

To edit an image in the CyberLink PhotoNow! program, select an image clip, then click the **PhotoNow!** button. PhotoNow! is the quickest way to touch-up your photos. You can resize, crop, rotate, remove red eye, adjust the color and brightness, and more. For more information on using the CyberLink PhotoNow! program, see that program’s online help.
Set a Video Clip’s Interlacing Format

All video clips have an interlacing (TV) format, which specifies how frames are displayed. Using video clips with conflicting (or incorrect) TV formats can result in degraded video quality in your final production.

Before you produce your movie, set all of the video clips to the same format. While PowerDirector can normally detect and suggest the correct format, some interlaced video (such as a video with very little motion) may be misjudged as a progressive video. PowerDirector automatically produces interlaced video for DVD, SVCD, and DV-AVI. Only change this setting if you are sure that PowerDirector has wrongly set the format.

Note: This is an extremely important step to take before production, as it can drastically affect final video quality!

To set a video clip’s TV format, do this:

1. Right-click the video clip whose interlacing format you want to set and select Set TV format. The Interlace and Progressive Settings dialog box opens.

2. Select an interlacing option:
   - If you know the interlacing format you want to use, select the corresponding option
   - If you do not know the interlacing formation you want to use, select Scan and Suggest Format. PowerDirector scans the clip and automatically selects the best format.

3. Click OK.
Change Audio Clip Volume Levels

Your movie may contain audio portions in the Music track, the Voice track, as well as in the video clips you have added. Since all of these tracks have probably been recorded at different levels, the result of so many audio sources can produce an overwhelming and confusing sound track. However, the audio levels of all of these different tracks can be mixed to produce a more harmonious sound track to your movie. Audio levels can be mixed in the Audio Mixing Room or inside the audio clips in the Music and Voice tracks.

In-Track Audio Mixing

You can change the level of volume at any point within an audio clip in the Timeline.

To change the volume level of an audio track in the Timeline, do this:

1. Select the clip you want to modify.
2. Click on the audio level line at the point where you want to change the audio level to set a volume key. Drag the volume key up to increase the volume or down to decrease the volume.

- Set levels at fewer volume keys along the track for subtler changes in volume, or more volume keys for more extreme changes in volume.
- To remove a volume key, drag it outside the clip’s borders.
Mix Audio Levels in the Audio Mixing Room

Using the Audio Mixer in the Audio Mixing Room gives you very precise control over the volume levels of the audio clips in the workspace. The Audio Mixer contains audio mixing controls for the different audio tracks in the workspace. The Audio Mixing Room appears as follows:

To mix audio in the Audio Mixing Room, do this:

1. Click 🎧. The Audio Mixing Room opens.
2. Click Play.
3. Use the sliders to mix the volume levels of the corresponding tracks.
   - Use the vertical sliders to set volume keys to increase or decrease the volume of the track on the fly.
   - Use the horizontal sliders to increase or decrease the volume of the entire track.
4. Click ❌ to close the Audio Mixing Room.
Add a Fade Effect to an Audio Clip

To add a fade-in/fade-out effect to an audio clip, do this:

1. Click 🎧. The Audio Mixing Room opens.
2. Click the button corresponding to the type of fade effect you want:
   • Click 🎧 to add a fade-in effect.
   • Click 🎧 to add a fade-out effect.
3. Click ❌ to close the Audio Mixing Room.

Restore an Audio Clip’s Volume Levels

If you are dissatisfied with the volume level of any audio clip after manually setting volume keys, you can easily restore the clip’s original volume level. To do this, right-click the track and select Restore Original Volume Level. Any audio volume keys you have added are permanently removed.
Using Magic Tools

PowerDirector’s Magic Tools make working with audio, video, and image clips easier than ever before. PowerDirector offers the following Magic Tools:

- **Magic Clean**: Cleans audio, video, and image clips.
- **Magic Motion**: Zooms and pans image clips.
- **Magic Cut**: Automatically condenses long video segments into shorter clips that contain only the best moments.
- **Magic Music**: Adds background music that automatically adjusts to suit different durations.

When you open a magic tool, two buttons are available for viewing the clip. These buttons open windows that allow you to compare the clip before and after modification. Descriptions of the windows are below:

- **Original**: Displays the clip as it appears before the current effect is applied.
- **Output**: Displays the clip with the current modification applied.
**Magic Clean**

PowerDirector’s Magic Clean tool can be used to clean up image files, video files, as well as audio files. The Magic Clean tool can help revitalize your project by making your media clips cleaner, sharper, and brighter and your audio files crisper and clearer.

**Perform Magic Clean on an Image Clip**

When applied to image clips, PowerDirector’s Magic Clean tool enhances the image for a sharper, brighter picture. This tool is ideal for use with photos taken when lighting is either insufficient or too intense.

To perform Magic Clean on an image clip, select the clip in the timeline, then click the Magic Clean button. The Magic Clean dialog box opens.

The following options are available:

- **Apply EagleVision to enhance photos**: Adjusts the brightness/contrast/saturation ratios so that you do not need to change the color settings if the clip contains portions that are overly dark or bright.
- **Automatically remove red-eye**: Automatically removes the red-eye caused by flash photography from a photo.
Perform Magic Clean on a Video Clip

When applied to video clips, PowerDirector’s Magic Clean tool automatically adjusts the video output for a sharper, brighter picture. This tool is ideal for use with video recorded when lighting is either insufficient or too intense. There are also noise reduction options that can be applied to the audio portion of a video clip.

To perform Magic Clean on a video clip, select the clip in the timeline, then click . The Magic Clean dialog box opens.

The following options are available:

- **Apply EagleVision to enhance video**: Adjusts the brightness/contrast/saturation ratios so that you do not need to change the color settings if the clip contains portions that are overly dark or bright.
- **Remove audio noise**: Filters out noise from the audio track. Drag the slider to remove more or less noise.
- **Original audio recorded outdoors**: Applies a specific noise reduction technology to reduce background noise created by recording outside.
- **Filter out wind noise**: Applies a specific noise reduction technology to filter out wind noise.
Perform Magic Clean on an Audio Clip

The Magic Clean tool is ideal for use with audio clips that were recorded outdoors, in a room with poor acoustics - even in a car or other noisy location. The Magic Clean tool uses CLNR (CyberLink Noise Reduction) technology to improve output audio.

To perform Magic Clean on an audio clip, select the clip in the timeline, then click . The Magic Clean dialog box opens.

The following options are available:

- **Remove audio noise**: Filters out noise from the audio track. Drag the slider to remove more or less noise.
- **Original audio recorded outdoors**: Applies a specific noise reduction technology to reduce background noise created by recording outside.
- **Filter out wind noise**: Applies a specific noise reduction technology to filter out wind noise.
Magic Motion

PowerDirector’s Magic Motion tool zooms or pans an image clip, creating a motion effect in your final movie. The Magic Motion tool is ideal for turning slide shows into engaging presentations - especially when combined with Magic Music.

To perform Magic Motion on an image clip, select the clip in the timeline, then click . The Magic Motion dialog box opens.

The following options are available:

- **Automatically set focus**: Check this option to set the focus on the image automatically. Setting a focus in portrait layout pans across the image. Setting a focus in landscape layout zooms in on the image.

- **Apply to Adjacent Photos**: Click this button to apply the Magic Motion effect to all neighboring photos in the timeline and add a crossfade between the clips. (You can set the crossfade option in File Preferences. See File Preferences on p.40.)

- **Remove Magic**: Click this button to remove the Magic Motion effect from the clip.

Once you apply the Magic Motion effect, an icon appears on the clip in the timeline, indicating that Magic Motion has been applied. If you later decide to remove the Magic Motion effect, open the Magic Motion dialog box, then click **Remove Magic**.
Magic Cut

You can fit a video clip to a specific time by automatically cutting out unnecessary portions and keeping only the best moments. The Magic Cut feature uses “magic” video technology to locate and keep the most interesting moments, while discarding sections of lesser importance. The Magic Cut tool is ideal for condensing long video segments into shorter clips - for example, cutting one hour of video down to ten minutes.

**Note:** If the video segment you are using is shorter than 15 minutes in length, has been previously edited, or contains extremely important moments, you may prefer to edit it manually - for example, by using the Multi Trim function. See Perform a Multiple Trim on p.70.

To perform Magic Cut on a video clip, select the clip in the timeline, then click . The Magic Cut dialog box opens.

The following options are available:

- **New Duration:** Enter the duration you would like to give to the clip (in hours:minutes:seconds:frames).
- **Scene with zoom/pan/motion:** Adds a crossfade effect between the clips created when you apply the Magic Cut effect.
- **Scenes with people speaking:** Selects clips with more or less dialog.
- **Scenes with long duration:** Cuts the original video into longer clips. Drag the slider to set relatively longer or shorter durations.
Magic Music

Magic Music automatically adjusts the playback of the music clips it contains to fit any length from 5 seconds to 2 hours, and fine-tunes the audio for a smooth cut-off. The Magic Music tool is ideal for use with photo slide shows.

Note: Click the SmartSound button to view SmartSound-related copyright and purchasing information.

To add a Magic Music audio clip to the timeline, do this:


2. Select a style from the drop-down menu.
3. Choose a song.
4. Set the desired duration in the duration box.
5. Select a variation, then drag it into the Music track.
6. Drag the clip’s border to a suitable duration.
Modifying Effects

Most effects boast a number of options that you can set individually to increase or decrease the intensity of the effect, or to achieve more creative results. In fact, this section describes some of the most creative functions found within the PowerDirector program. Mastering the procedures found in this section will go a long way towards making you a digital video editing expert!

Set an Effect’s Hold Time

Some effects (title and PiP effects in particular) contain inherent motion, moving across the screen as they affect the video in your movie. You can set the relative amount of time the effect remains still onscreen between its arrival and departure in both the preview window and the Media Editor.

To set an effect’s hold time, do this:

1. Set a title or PiP effect.
2. Click the effect in the Timeline.
3. Preview it in either the preview window or the Media Editor. For more information on the preview window, see Preview an Effect in the Preview Window on p.110. For more information on the Media Editor, see Preview an Effect in the Media Editor on p.112.
4. Drag the Mark in and Mark out sliders to set the effect’s hold time. (The orange bar represents the hold time.)
Set an Effect’s Duration

The procedure below describes how to set the duration of a video, title, or transition effect. The procedure for PiP effects has only a slight difference.

Set an Effect’s Duration Using the Duration Setting Box

To set an effect’s duration using the Duration Setting box, do this:

1. Select the effect you want to modify.
2. Display the timecode box. You may do this in one of the following ways:
   - **Video/title/transition effects**: Click **Duration**. The Duration Setting dialog opens.
   - **PiP effects**: Click **Trim**. The PiP Trim Options panel opens, displaying the timecode box in the upper right-hand corner.

   **Note**: To set a PiP effect’s duration using the Trim options, see Trim a Video or Audio Clip on p.69.

3. Set the duration, then do one of the following:
   - **Video/title/transition effects**: Click **OK**.
   - **PiP effects**: Click ![exit icon] to close the options panel and return to the normal Library view.
Set an Effect’s Duration Manually

You can set an effect’s duration manually by dragging the edges of the effect in the Timeline. The procedure for dragging the edges of an effect is the same for video, title, PiP, and transition effects.

**Note:** Video clips used in a PiP cannot be lengthened beyond their original duration. Transitions can be lengthened to half of the duration of the shortest clip they affect.

To set an effect’s duration manually, do this:

1. Select the effect whose duration you want to set manually.
2. Position your cursor at one end of the effect and drag the end of the clip to the new position.

   ![Image](image.png)

**Note:** You can drag the edge of a clip to lengthen it or to shorten it. If you compress the start of a video or audio clip, playback begins at a later frame within the clip. If you compress the ending, playback ends at an earlier frame within the clip.
Modifying a Video Effect

Video effects are applied to the Effect track at the time position of the video or image clip(s) that you want to affect. Video effects only affect the clips in the Video track that appear within the effect’s duration.

To modify a video effect, do this:

1. Select the video effect in the Effect track and click **Modify**. The Effect Modifications Options panel opens.

2. Set the intensity level of the video effect. A preview of the effect appears in the preview window. (Options vary according to the video effect you select.)
   - Many options provide a slider to increase or decrease the intensity of the effect.
   - Some effects provide a drop-down list in which you can choose an effect option.

   - Click **F** to change two settings in proportion with each other.
   - Click **Reset** to restore the original effect settings.

3. Click **L** to close the options panel and return to the normal Library view.
Modifying a PiP Effect

A picture-in-picture effect allows you to insert an image or a video into an existing image or video clip in your movie, effectively overlaying the picture-in-picture clip on top of the existing clip. You can modify the degree of transparency of the overlapping clip, as well as its position, motion, and other properties.

PiP effects have many options that you can modify independently. These include a border, a shadow, a motion effect, a color filter, size and position, and transparency.

Change the Speed of a PiP Effect

Slow-motion or fast-motion effects can grab your audience’s attention as well as break up the rhythm of a movie.

To change the speed of a PiP effect, do this:

1. Select the PiP effect video clip that you want to modify.
2. Click Speed. The speed option panel opens.
3. Drag the slider to set the new speed (between .1x and 10x).
4. Click to close the option panel.
Add a Border to a PiP Effect

You can add a border around the clip in a PiP effect. Available options allow you to change the border’s color and size and to add a transparency or blur effect.

To change the border of a PiP effect, do this:

1. Select the PiP effect video clip that you want to modify, then click **Modify**. The PiP Modification Options panel opens.
2. Click ![Border Icon]. The PiP Designer opens.
3. Set the PiP border options that you want to apply:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Apply border</strong></td>
<td>Check to apply the font face settings. Uncheck to remove the font face settings.</td>
</tr>
<tr>
<td><strong>Size</strong></td>
<td>Drag the slider to increase or decrease the size of the border.</td>
</tr>
<tr>
<td><strong>Blur</strong></td>
<td>Drag the slider to increase or decrease the blur effect of the border.</td>
</tr>
<tr>
<td><strong>Transparency</strong></td>
<td>Drag the slider to increase or decrease the transparency of the border.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Uniform color</td>
<td>Check to set the border in a single color. Click the eyedropper to open the Color dialog box, in which you can select a color.</td>
</tr>
<tr>
<td>Gradient color</td>
<td>Check to set the border in a color gradient.</td>
</tr>
<tr>
<td>Begin</td>
<td>Click the eyedropper to open the Color dialog box, in which you can select the color at the start of the gradient.</td>
</tr>
<tr>
<td>End</td>
<td>Click the eyedropper to open the Color dialog box, in which you can select the color at the end of the gradient.</td>
</tr>
<tr>
<td>Gradient direction</td>
<td>Click a dimple to indicate the direction of the gradient.</td>
</tr>
</tbody>
</table>

**Note:** Whenever you set an option in the PiP Designer, a preview of the effect is instantly displayed.

4. **Click OK** to close the PiP Designer.
Add a Shadow to a PiP Effect

You can add a shadow around the clip in a PiP effect. Available options allow you to change the shadow’s color and size and to add a transparency or blur effect.

To add a shadow to a PiP effect, do this:

1. Select the PiP effect video clip that you want to modify, then click **Modify**. The PiP Modification Options panel opens.
2. Click **Shadow**. The PiP Designer opens.
3. Set the PiP shadow options that you want to apply:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Apply shadow</strong></td>
<td>Check to apply the shadow settings. Uncheck to remove the shadow settings.</td>
</tr>
<tr>
<td><strong>Distance</strong></td>
<td>Drag the slider to increase or decrease the distance between the shadow and the font face.</td>
</tr>
<tr>
<td><strong>Blur</strong></td>
<td>Drag the slider to increase or decrease the blur effect of the shadow.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Transparency</td>
<td>Drag the slider to increase or decrease the transparency of the shadow.</td>
</tr>
<tr>
<td>Color picker</td>
<td>Click the eyedropper to open the Color dialog box, in which you can select the color of the shadow.</td>
</tr>
<tr>
<td>Shadow direction</td>
<td>Click a dimple to indicate the direction of the shadow.</td>
</tr>
</tbody>
</table>

**Note:** Whenever you set an option in the PiP Designer, a preview of the effect is instantly displayed.

4. Click **OK** to close the PiP Designer.
Add Motion to a PiP Effect

You can add a motion to the clip in a PiP effect. Available options allow you to set the start and end locations, add a fade-in or fade-out, and begin or end the effect off screen.

To add motion to a PiP effect, do this:

1. Select the PiP effect video clip that you want to modify, then click **Modify**. The PiP Modification Options panel opens.
2. Click ![PiP Designer](image). The PiP Designer opens.
3. Set the PiP motion options that you want to apply:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PiP starting position</td>
<td>Select the position at which you want the PiP clip to begin its motion from the drop-down list. (Select <strong>Still</strong> if you do not want the PiP clip to move at the beginning of the effect.)</td>
</tr>
<tr>
<td>Start off screen</td>
<td>Check this option if you want the PiP clip to begin off screen.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Fade-in</td>
<td>Check this option if you want the PiP clip to fade in at the beginning of the effect.</td>
</tr>
<tr>
<td>PiP ending position</td>
<td>Select the position at which you want the PiP clip to end its motion from the dropdown list. (Select <strong>Still</strong> if you do not want the PiP clip to move at the end of the effect.)</td>
</tr>
<tr>
<td>End off screen</td>
<td>Check this option if you want the PiP clip to end off screen.</td>
</tr>
<tr>
<td>Fade-out</td>
<td>Check this option if you want the PiP clip to fade out at the end of the effect.</td>
</tr>
</tbody>
</table>

**Note:** Whenever you set an option in the PiP Designer, a preview of the effect is instantly displayed.

4. Click **OK** to close the PiP Designer.
Add a Color Filter to a PiP Effect

When you add a color filter to a clip in a PiP effect, portions of the underlying clip show through the overlaid clip wherever the selected color occurs.

To add a color filter to a PiP effect, do this:

1. Click the media clip in the PiP track you want to modify, then click **Modify**. The PiP Modification Options panel opens.
2. Check **Apply color filter**. This filters the selected color out of the image (i.e.: makes that color transparent).
3. Click the eyedropper tool. A dialog box opens, in which you can select a color from the media clip in your PiP effect.

4. Select the color from the clip that you would like to make transparent, then click **OK**.
   - To select more accurately, you can zoom in or out of the image. To do this, click select a magnification percentage
from the drop-down list, then click the \[ \text{🔍} \] button to zoom in or the \[ \text{🔍} \] button to zoom out.

5. Set a **Tolerance** level to extend or restrict the range of colors affected by the filter. Do this in one of the following ways:
   - Drag the Tolerance level slider.
   - Click the \[ \text{🔍} \] button to increase the level or the \[ \text{🔍} \] button to decrease the level.

6. Click \[ \text{☐} \] to close the options panel and return to the normal Library view.
Modify a PiP Effect’s Size and Position

You can change both the size and the position of the media clip in a PiP effect. Resizing options are unrestricted. You can reduce the clip to miniature size or enlarge it to completely obscure the underlying media file.

To modify a PiP effect’s size and position, do this:

1. Click the media clip in the PiP track, then click **Modify**. The PiP Modification Options panel opens.
2. Modify the PiP clip’s size and position in the preview window:
   - Drag the PiP clip to a desired location over the underlying clip.
   - Drag the edge of the PiP clip to a desired size. Check **Keep aspect ratio** to constrain the ratio of the length and width of the PiP clip. Uncheck this option to change the aspect ratio freely.
3. Click ➡️ to close the options panel and return to the normal Library view.

Modify a PiP Effect’s Transparency Level

You can modify the transparency level of the media clip in a PiP effect. Transparency options range from entirely transparent to totally opaque.

To modify a PiP effect’s transparency level, do this:

1. Click the media clip in the PiP track, then click **Modify**. The PiP Modification Options panel opens.
2. Set the **Transparency** level to increase or decrease the transparency of the superimposed clip.
3. Click ➡️ to close the options panel and return to the normal Library view.
Modify a Title Effect

Using title effects allows you to add text to your movie - as a title at the beginning, an element during the main story, or as credits at the very end. Besides changing the look of the text itself, you can also send the text running on a path across the screen. Title effects only affect the clips in the Video track that appear within the effect’s duration.

Title effects contain font face and shadow options, which you can modify to best suit your movie. All of these options are found in the Title Designer.

Modify a Title Effect’s Font Face

You can modify the font used in a title effect, including the size, color, font type used, weight, alignment, transparency, and blur effect. Further tools aid in the precise positioning of the title on the screen and indicate the on-screen area that is safe for TV display.

1. Select a title effect in the Title track, then click Modify. The Title Designer opens.
2. Set the text font face options that you want to apply

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><a href="#">Roller Coaster Left</a></td>
<td>Click to select a title effect.</td>
</tr>
<tr>
<td><a href="#">Arial</a></td>
<td>Click to select a font type.</td>
</tr>
<tr>
<td><img src="#" alt="Font Size" /></td>
<td>Click to select a font size.</td>
</tr>
<tr>
<td><img src="#" alt="Bold" /></td>
<td>Click to make text bold.</td>
</tr>
<tr>
<td><img src="#" alt="Italic" /></td>
<td>Click to make text Italicized.</td>
</tr>
<tr>
<td><img src="#" alt="Align Left" /></td>
<td>Click to left-align text.</td>
</tr>
<tr>
<td><img src="#" alt="Align Center" /></td>
<td>Click to center-align text.</td>
</tr>
<tr>
<td><img src="#" alt="Align Right" /></td>
<td>Click to right-align text.</td>
</tr>
<tr>
<td><img src="#" alt="Title Mask" /></td>
<td>Click to add/remove a title mask.</td>
</tr>
<tr>
<td><img src="#" alt="Grid Lines" /></td>
<td>Click to add/remove grid lines that can aid in the precise positioning of text on the screen. Grid lines do not appear when you preview or produce your movie.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>TV Safe Zone</td>
<td>Click to add/remove the TV Safe Zone outline, which represents the area in which video content from your movie is certain to appear on TV screens, which have a smaller display area than computer monitors. The TV Safe Zone outline does not appear when you preview or produce your movie.</td>
</tr>
<tr>
<td>Apply font face</td>
<td>Check to apply the font face settings. Uncheck to remove the font face settings.</td>
</tr>
<tr>
<td>Blur</td>
<td>Drag the slider to increase or decrease the blur effect of the font face.</td>
</tr>
<tr>
<td>Transparency</td>
<td>Drag the slider to increase or decrease the transparency of the font face.</td>
</tr>
<tr>
<td>Uniform color</td>
<td>Check to set the font face in a single color. Click the eyedropper to open the Color dialog box, in which you can select a color.</td>
</tr>
<tr>
<td>Gradient color</td>
<td>Check to set the font face in a color gradient.</td>
</tr>
<tr>
<td>Begin</td>
<td>Click the eyedropper to open the Color dialog box, in which you can select the color at the start of the gradient.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>End</strong></td>
<td>Click the eyedropper to open the Color dialog box, in which you can select the color at the end of the gradient.</td>
</tr>
<tr>
<td><strong>Gradient direction</strong></td>
<td>Click a dimple to indicate the direction of the gradient.</td>
</tr>
</tbody>
</table>

**Note:** Whenever you set an option in the Title Designer, a preview of the effect is instantly displayed.

3. Click **OK** to close the Title Designer.
Mask a Title Effect

Masking a title effect hides the portion of the title effect that is located within the mask.

To mask a title effect, do this:

1. Select a title effect in the Title track, then click **Modify**. The Title Designer opens.
2. Click 🗝. Bars appear around the perimeter of the clip.
3. Drag the title mask bars to specify the area you want to mask. Any text that appears outside this area does not appear when the clip is played.

4. Click **OK** to close the Title Designer.
Add a Shadow to a Title Effect

You can add a shadow around the text in a title effect. Available options allow you to change the shadow’s color and size and to add a transparency or blur effect.

1. Click 📺 to open the Shadow settings.

2. Set the text shadow options that you want to apply:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Apply shadow</strong></td>
<td>Check to apply the shadow settings. Uncheck to remove the shadow settings.</td>
</tr>
<tr>
<td><strong>Distance</strong></td>
<td>Drag the slider to increase or decrease the distance between the shadow and the font face.</td>
</tr>
<tr>
<td><strong>Blur</strong></td>
<td>Drag the slider to increase or decrease the blur effect of the font face.</td>
</tr>
<tr>
<td><strong>Transparency</strong></td>
<td>Drag the slider to increase or decrease the transparency of the font face.</td>
</tr>
</tbody>
</table>
Fill shadow | Check to fill in the gap between the shadow and the font face.

Color picker | Click the eyedropper to open the Color dialog box, in which you can select the color of the shadow.

Shadow direction | Click a dimple to indicate the direction of the shadow.

3. Click **OK** to close the Title Designer.
Preview a Clip

As you add media to your production, it is important to preview the effect your media clips have on the story you are telling. You may want to preview imported clips, for example, to verify their content, or to preview clips you have captured to see if they contain sections you need to trim.

Preview Window

The easiest way to preview a media clip is by playing it in the preview window to the right of the Library. Any media clip that appears in the Library or the workspace can be previewed in this window. However, playback controls are only available for video and audio media.
Preview a Clip in the Preview Window

To preview a media clip in the preview window, do this:

1. Click the clip or effect you want to preview. The clip appears in the preview window.

   **Note:** When previewing clips in the workspace, ensure that the preview window is in Clip mode. If the preview is in Movie mode, click the **Clip** button before previewing a clip.

2. Locate the point at which you want to begin your preview. You may do this in one of the following ways:
   - Drag the Timeline slider.
   - Drag the preview window slider.
   - Enter a timecode in the timecode box.

3. Press **Play**. The preview starts from the point you have specified.

4. Use the playback buttons to control the preview.

Preview an Effect in the Preview Window

Previewing effects is an important step in ensuring not only that the effect is applied to the proper clip in the proper location, but that the intensity of the effect is suitable for that location in the movie. You will likely preview effects constantly as you apply them to the workspace, and it is a good idea to preview your movie at regular intervals to ensure that your editing is proceeding as you planned.

To preview an effect in the preview window, do this:

1. Click the effect in the Timeline. The media clip the effect is applied to appears in the preview window.

2. Locate the point at which you want to begin your preview. You may do this in one of the following ways:
   - Drag the Timeline slider.
   - Drag the preview window slider.
   - Enter a timecode in the timecode box.

3. Press **Play**. The preview starts from the point you have specified.

4. Use the playback buttons to control the preview.
Media Viewer

The Media Editor is similar to the Media Viewer but offers additional functions for trimming video clips. Previewing clips in the Media Viewer gives you a larger preview picture than the preview window.

The Media Viewer allows you to preview media clips as well as your entire movie production in a large, resizable window.

Preview window
Provides playback controls to preview your movie

Playback controls
Allow you to control playback of clips
Preview a Clip in the Media Viewer

To preview a clip in the Media Viewer, do this:

1. Right-click the clip in the Library.
2. Select **Play in Media Viewer**. The clip appears in the Media Viewer.
3. Locate the point at which you want to begin your preview. You may do this in one of the following ways:
   - Drag the Timeline slider.
   - Drag the preview window slider.
   - Enter a timecode in the timecode box.
4. Press **Play**. The preview starts from the point you have specified.
5. Use the playback buttons to control the preview.

**Note:** Use the slider in the magnified timeline for more precise preview control.

Preview an Effect in the Media Editor

To preview an effect in the Media Editor, do this:

1. Click the effect in the Timeline.
2. Click [ ]. The Media Editor opens.
3. Locate the point at which you want to begin your preview. You may do this in one of the following ways:
   - Drag the Timeline slider.
   - Drag the preview window slider.
   - Enter a timecode in the timecode box.
4. Press **Play**. The preview starts from the point you have specified.
5. Use the playback buttons to control the preview.

**Note:** Use the slider in the magnified timeline for more precise preview control.
Chapter 5:

Producing Your Movie

After your movie has been completely edited, you are ready to produce your movie. Producing a movie simply means compiling (or rendering) the separate elements it contains into one playable movie file. As your movie can be destined for different uses, PowerDirector has several options to produce movies suited to any need.

This chapter contains the following sections:

- Production Mode on p.114
- The Production Wizard on p.115
- Produce a Disc on p.117
- Create a File on p.119
- Create a Streaming File on p.134
- Write Back to DV Tape on p.143
- Burning on p.146
Production Mode

When you click the  button, PowerDirector enters Production mode, in which you can compile your movie into a file that is ready for a variety of destinations, including burning to disc. In Production mode, PowerDirector opens the Production Wizard.

Preview window
Provides playback controls to preview your movie
The Production Wizard

The Production Wizard is a simple interface that makes movie production easy. When you click the Production Wizard opens.

Note: Before producing your movie, make sure that all of your video clips have the same interlacing format. This is an extremely important step to take before production, as it can drastically affect final video quality! If you produce your movie and find the video quality unsatisfactory, verify that the interlacing format of all of your video clips is the same. If your clips have different interlacing formats, set them all to the same format, then produce your movie again. For more information, see Set a Video Clip’s Interlacing Format on p.77.
The opening window contains a preview window, a visual display of your hard disk space, and four buttons corresponding to the four production options available in The Production Wizard. These are described below:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Produce a Disc</strong></td>
<td>Allows you to create a movie production that you can then burn to disc. See Produce a Disc on p.117.</td>
</tr>
<tr>
<td><strong>Create a File</strong></td>
<td>Allows you to create a movie production that you can then watch on your computer See Create a File on p.119.</td>
</tr>
<tr>
<td><strong>Create a Streaming File</strong></td>
<td>Allows you to create a movie production that you can then stream over the Internet. See Create a Streaming File on p.134.</td>
</tr>
<tr>
<td><strong>Write Back to DV Tape</strong></td>
<td>Allows you to create a movie production that you can then write back to DV tape. See Write Back to DV Tape on p.143.</td>
</tr>
</tbody>
</table>
Produce a Disc

You may want to burn your movie to disc so that you and your friends and family can enjoy watching it on a computer or a disc player. This section describes how to produce a movie that you can burn to disc after the production process is finished.

To produce a movie that you can burn to disc, do this:

1. Click to open the Production Wizard.
2. Click , then Next. Disc production options appear on the page.
3. Select a disc format, then set your options:
   - To set a destination folder for the produced movie, click Output to, then choose a new folder.
   - Country/Video Format of Disc: Specify the location where you want to play the disc you create.
   - Profile: Select a profile category (Default, Custom, or All) from the Profile drop-down, then a specific profile from the drop-down to the right.
4. Click **Continue Authoring** to continue the production process by burning a disc in CyberLink PowerProducer after your movie is compiled.

- Production does not start automatically at this point. Instead, you are given the opportunity to further edit your disc, then start production when you are ready.

**Note:** For help using CyberLink PowerProducer, see the help file inside that program.
Create a File

You may want to produce your movie as a file that you can watch on your computer. PowerDirector allows you to create files in AVI, MPEG-1, or MPEG-2 format. The procedures for creating each of these file types are described in the section below.

Create an AVI File

There are two types of AVI files: DV-AVI or Windows AVI.

DV-AVI

To produce a DV-AVI movie that you can watch on your computer, do this:

1. Click to open the Production Wizard.
2. Click , then Next. File generation production options appear on the page.
3. Select the AVI file format.
4. Select the DV-AVI format from the drop-down list.
5. Select NTSC or PAL from the drop-down list.
• **Use SVRT to save rendering time:** Keep this option checked (when it is enabled) to reduce production time. For more information on SVRT, see What is SVRT/SVRT II and when can I use it? on p.160 and SVRT, SVRT II on p.173.

6. Click . A dialog box opens. Set your options, if necessary:

   - Select **Type I** or **Type II**. For more information on these two types, see Type I and Type II on p.174.
   - Select **High Quality** or **Medium Quality**. For more information on video quality, see Video Qualities on p.169.
   - To review your production settings, click . A dialog box opens, in which you can verify the profile’s details.
7. Click **Next**. Production details appear on the page. Verify that these details are correct.

- You can change the video file name and destination folder. To do this, click **xxx**, then enter a new name or locate a new folder.
- To ensure that all of your video clips have the same interlacing format, click **Scan source video clips and set field order**.

8. Click **Start**. The production process begins. This process may take a few minutes.

- To stop the production process before completion, click **Abort**.
- To return to Edit mode after production is complete, click **Home**.
Windows AVI

To produce a Windows AVI movie that you can watch on your computer, do this:

1. Click to open the Production Wizard.
2. Click , then Next. File generation production options appear on the page.

3. Select the AVI file format.
4. Select the Windows AVI format from the drop-down list.
5. Select a video quality from the drop-down list.
6. Click **Next**. Production details appear on the page. Verify that these details are correct.

   ![Production Details](image)

- You can change the video file name and destination folder. To do this, click **...**; then enter a new name or locate a new folder.
- To ensure that all of your video clips have the same interlacing format, click **Scan source video clips and set field order**.

7. Click **Start**. The production process begins. This process may take a few minutes.
   - To stop the production process before completion, click **Abort**.
   - To return to Edit mode after production is complete, click **Home**.
Create a DivX File

You can create a DivX file for a number of different uses: as an email attachment, for playback on a media player, for viewing on a TV, or for writing to VHS tape.

To produce a DivX movie, do this:

1. Click to open the Production Wizard.
2. Click , then Next. File generation production options appear on the page.
3. Select the DivX file format.
4. Click **Next**. Production details appear on the page. Verify that these details are correct.

- You can change the video file name and destination folder. To do this, click **....** then enter a new name or locate a new folder.
- To ensure that all of your video clips have the same interlacing format, click **Scan source video clips and set field order**.

5. Click **Start**. The production process begins. This process may take a few minutes.

- To stop the production process before completion, click **Abort**.
- To return to Edit mode after production is complete, click **Home**.
Create an MPEG-1/MPEG-2 File

To produce an MPEG-1/MPEG-2 movie that you can watch on your computer, do this:

1. Click to open the Production Wizard.

2. Click , then Next. File generation production options appear on the page.

3. Select the MPEG-1/MPEG-2 file format, then select a profile.
4. Click **Next**. Production details appear on the page. Verify that these details are correct.

- You can change the video file name and destination folder. To do this, click ..., then enter a new name or locate a new folder.

5. Click **Start**. The production process begins. This process may take a few minutes.

- To stop the production process before completion, click **Abort**.
- To return to Edit mode after production is complete, click **Home**.
Create/Modify a Profile

You can create a new profile, or modify an existing profile’s settings, in order to better suit your production needs.

Change AVI Profile Settings

1. Click . A dialog box opens. Set your options, if necessary:

- **Compression Codec**: Select a codec from the drop-down list.
- **Key Frame**: This field, when available, allows you to set the number of key frames in your video, but this number cannot be set for most codecs. For more information on key frames, see key frame on p.171.
- **Data rate**: Select a data rate from the drop-down list.
- **Composition**: Select the media type to be compressed in your final movie production: **Video and audio**, **Video only**, or **Audio only**.
- The Codec Settings... and About buttons open dialog boxes with options and information about the individual compression/decompression schemes.
- **Better Compression/Better Quality**: Drag the slider to select a setting between smaller production file size and better video quality.
2. Click the Video/Audio Settings tab and set your options, if necessary:

- **Frame(s):** Select a frame rate from the drop-down list.
- **Video Size:** Select a video display size from the drop-down list.
- **Colors:** Select a color scheme from the drop-down list.
- **Format:** Select an audio format from the drop-down list.
- **Attributes:** Select audio attributes from the drop-down list.
- To verify the profile’s properties, click ![OK](image). A dialog box opens, in which you can verify the profile’s details.
Change DivX Profile Settings

1. Click \(\text{Edit}\). A dialog box opens. Set your options, if necessary:

- **Compression Codec**: Select a codec from the drop-down list.
- **Key Frame**: This field, when available, allows you to set the number of key frames in your video, but this number cannot be set for most codecs. For more information on key frames, see key frame on p.171.
- **Data rate**: Select a data rate from the drop-down list.
- **Composition**: Select the media type to be compressed in your final movie production: Video and audio, Video only, or Audio only.
- The **Codec Settings...** and **About** buttons open dialog boxes with options and information about the individual compression/decompression schemes.
- **Better Compression/Better Quality**: Drag the slider to select a setting between smaller production file size and better video quality.
2. Click the Video/Audio Settings tab and set your options, if necessary:

- **Frame(s)**: Select a frame rate from the drop-down list.
- **Video Size**: Select a video display size from the drop-down list.
- **Colors**: Select a color scheme from the drop-down list.
- **Format**: Select an audio format from the drop-down list.
- **Attributes**: Select audio attributes from the drop-down list.
- To verify the profile’s properties, click . A dialog box opens, in which you can verify the profile’s details.
Create a New MPEG-1/MPEG-2 Profile

MPEG production profiles can be used when you produce a movie for a disc or when you create an MPEG-1 or MPEG-2 file. You can create custom production profiles if none of the existing profiles suit your specific production requirements.

To create a new custom production profile, do this:

1. Click the Profile Setup button. The Profile Setup dialog box appears.

2. Enter a new profile name.

3. Click the Video tab and modify the video options, if necessary:

- **Video Size**: Select a video display size from the drop-down list.
- **Video Compression Bitrate**: Drag the slider to increase or decrease video bitrate. An increased bitrate (set by dragging the slider to the right) results in a larger file size and increased production time.
• **Smoothing**: Check to produce a softer video image. Only use this option if it was not used during capture, as it can result in slightly blurred video quality.

• **Noise removal**: Check to remove video artefacts. Only use this option if it was not used during capture, as it can result in slightly blurred video quality.

• **Deinterlacing**: Check to create deinterlaced video. Deinterlacing improves the quality of interlaced video when displayed on a computer monitor, but does may degrade video quality in other cases.

• **High speed/High quality**: Drag the slider to select an acceptable setting between faster production speed with lower video quality and higher video quality with slower production speed.

4. Click the Audio tab and modify the audio option, if necessary:

   • **Audio Compression Rate**: Select a rate from the drop-down list. A higher rate yields better audio quality, but results in a larger file and increased production time.

5. Click **OK** to close the dialog box.

   • To edit a custom production profile, click [ ] and edit the necessary information.

   • To delete a profile, click [ ]. A warning message appears, asking if you want to delete the profile. Click **OK**. The profile is deleted.

   • To view a profile’s production details, select the profile whose details you want to view, then click [ ]. The Details dialog appears, displaying the profile’s details. Click **OK** to close the dialog.
Create a Streaming File

You may want to produce your movie as a video file that can be stored on a server for streaming over the Internet. PowerDirector allows you to create files in WMV, RealVideo, or QuickTime Movie format. The procedures for creating each of these file types are described in the section below.

Create a WMV File for Streaming

To produce a WMV movie that you can stream over the Internet, do this:

1. Click to open the Production Wizard.
2. Click , then Next. Streaming file production options appear on the page.
3. Select the WMV movie file format.
4. Select the movie setting that suits your production needs.
5. Click Next. Production details appear on the page. Verify that these details are correct.
• You can change the video file name and destination folder. To do this, click ..., then enter a new name or locate a new folder.

• To ensure that all of your video clips have the same interlacing format, click **Scan source video clips and set field order**.

**Note:** This is an extremely important step to take before producing your final movie, as it can drastically affect final video quality!

6. Click **Start**. The production process begins. This process may take a few minutes.

• To stop the production process before completion, click **Abort**.

• To return to Edit mode after production is complete, click **Home**.
Create a RealVideo File for Streaming

To produce a RealVideo movie that you can stream over the Internet, do this:

1. Click to open the Production Wizard.
2. Click , then Next. Streaming file production options appear on the page.
3. Select the RealVideo movie file format.
4. Enter the file’s properties:
   - **Title**: Enter a title for your movie.
   - **Copyright**: Enter copyright information for your movie.
   - **Author**: Enter author information for your movie.
   - **URL**: Enter the URL from which the file is streaming.
   - **Seconds**: Enter the video length in seconds.
   - You can select a production profile. For more information on profiles, see Create a New RealVideo Profile on p.137.
5. Click Next. Production details appear on the page. Verify that these details are correct.
   - You can change the video file name and destination folder. To do this, click , then enter a new name or locate a new folder.
To ensure that all of your video clips have the same interlacing format, click **Scan source video clips and set field order**.

**Note:** This is an extremely important step to take before producing your final movie, as it can drastically affect final video quality!

6. Click **Start**. The production process begins. This process may take a few minutes.
   - To stop the production process before completion, click **Abort**.
   - To return to Edit mode after production is complete, click **Home**.

**Create a New RealVideo Profile**

To create a new custom production profile, do this:

1. Click **Profile Setup**. The Profile Setup dialog box appears.

2. Enter a new profile name.
3. Click the Settings tab and modify the Video, Audio, and Target Audience Settings, if necessary:

4. Click **OK** to close the dialog box.

   - To edit a custom production profile, click ![Edit profile icon] and edit the necessary information.
   - To delete a profile, click ![Delete profile icon]. A warning message appears, asking if you want to delete the profile. Click **OK**. The profile is deleted.
   - To view a profile’s production details, select the profile whose details you want to view, then click ![View details icon]. The Details dialog appears, displaying the profile’s details. Click **OK** to close the dialog.
Create a QuickTime File for Streaming

To produce a QuickTime movie that you can stream over the Internet, do this:

1. Click to open the Production Wizard.
2. Click , then Next. Streaming file production options appear on the page.
3. Select the QuickTime movie file format.
4. Select a production profile. For more information on profiles, see Create a New QuickTime Profile on p.141.
5. Click Next. Production details appear on the page. Verify that these details are correct.
   - You can change the video file name and destination folder. To do this, click , then enter a new name or locate a new folder.
   - To ensure that all of your video clips have the same interlacing format, click Scan source video clips and set field order.

Note: This is an extremely important step to take before producing your final movie, as it can drastically affect final video quality!
6. Click **Start**. The production process begins. This process may take a few minutes.
   - To stop the production process before completion, click **Abort**.
   - To return to Edit mode after production is complete, click **Home**.
Create a New QuickTime Profile

To create a new custom production profile, do this:

1. Click . The Profile Setup dialog box appears.

2. Enter a new profile name.
3. Click the Video Compressor tab and set your Video Setting options:

- **Compressor Component**: Select a compression scheme display size from the drop-down list.
- **Video Size**: Select a video display size from the drop-down list.
- **Video Type**: Select a video codec type from the drop-down list.
- **Video Quality**: Select a video quality from the drop-down list.
- **Key Frame Rate**: Use the arrows to set a key frame rate (between 0 and 32). For information on key frames, see key frame on p.171.

4. Click **OK** to close the dialog box.

- To edit a custom production profile, click [ ] and edit the necessary information.
- To delete a profile, click [ ]. A warning message appears, asking if you want to delete the profile. Click **OK**. The profile is deleted.
- To view a profile’s production details, select the profile whose details you want to view, then click [ ]. The Details dialog appears, displaying the profile’s details. Click **OK** to close the dialog.
Write Back to DV Tape

You may want to produce your movie in order to write it back to DV tape. This allows you to store your movie in a convenient, digital format that can easily be imported into another computer for further editing.

To produce a movie that you can write back to DV tape, do this:

1. Click  to open the Production Wizard.
2. Click , then Next. Options for writing to disc appear on the page.
3. Click Next.
4. Click **Next**. Production details appear on the page. Verify that these details are correct.

5. Click **Start**. The production process begins. This process may take a few minutes.
   - To stop the production process before completion, click **Abort**.
   - To return to Edit mode after production is complete, click **Home**.

6. When production is complete, the Write to DV Tape dialog box opens.
7. Locate the position at which you would like to begin writing to tape. You may do this in one of the following ways:
   - Use the playback buttons.
   - Drag the time slider.
   - Enter a timecode in the timecode box.
8. Your produced movie file appears in a list in the window. Click + to add new files to the file list. Select a file and click − to remove it from the file list.
   - Select a file then click ‹ to bring it closer to the beginning of your movie when writing to tape. Click › to move it toward the end.
   - To ensure that all of your video clips have the same interlacing format, click Scan source video clips and set field order.

Note: This is an extremely important step to take before producing your final movie, as it can drastically affect final video quality!

9. Click Start. A message appears asking you to ensure your tape is at correct location and not write-protected. (Writing back to tape overwrite any content currently on the tape at that position.)
10. Click Yes. Writing begins.
    - Click Abort to stop.
    - If successful, a confirmation message appears.
11. Click OK.
Burning

When you are ready to burn your movie to disc, you should have several discs on hand that are compatible with your burning drive. Make sure not only that the media type is correct (i.e.: that you have DVDs for a DVD drive and CDs for a CD drive), but that your discs are all in the correct format (for example, CD-R or DVD+RW).

Keep several discs on hand in case your drive encounters errors, or to make duplicate copies when you are satisfied with the results.
Appendix

This chapter contains reference information to help answer questions you may have about the digital movie production process or about using CyberLink PowerDirector.

This chapter contains the following sections:

- Technical Support on p.148
- Hotkeys on p.150
- FAQ on p.158
- SVRT2: When Can I Use it? on p.162
- Disc Types & Formats on p.163
- Video Formats & Qualities on p.168
- Glossary on p.170
- Copyright Notices on p.175
Technical Support

Before seeking technical support, please read your user's guide or online help, and check out the Readme file for more information. You may also contact your local distributor/dealer. If your problem is still not resolved, the following sections provide ways to obtain technical support from CyberLink.

Web Support

Web support is available 24 hours a day:

support.gocyberlink.com

In addition to frequently asked questions, our website also provides troubleshooting techniques, the latest in product news, and other relevant information.

Fax Support

In order to answer your technical questions as quickly as possible, you may fax us at:

(886) 2-8667-1300

Note: Technical support is only offered to registered users, so please make sure to include your CD-key when faxing.
Telephone Support

You are welcome to call CyberLink’s Technical Support Hotline at:

(886) 2-8667-1298

Note: Technical support is only offered to registered users, so please make sure your CD-key is ready when calling.

Phone support hours are:

Monday-Friday, 9:00 a.m. - 5:00 p.m. Taiwan local time (GMT +8:00) excluding holidays.

When calling for support, please have your computer ready and provide us with the following information:

- registered CD-key
- product version
- Windows version
- hardware types (capture card, sound card, VGA card) and their specifications
- warning messages displayed
- detailed problem description and when it occurred
Hotkeys

PowerDirector allows you to employ a number of hotkeys to make working with video quicker and easier. These hotkeys are organized by function and described below.

System Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt + space bar</td>
<td>Open the Minimize menu in the top-left corner</td>
</tr>
<tr>
<td>Alt + F4</td>
<td>Exit PowerDirector</td>
</tr>
</tbody>
</table>

Project Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + N</td>
<td>Create new project</td>
</tr>
<tr>
<td>Ctrl + O</td>
<td>Open existing project</td>
</tr>
<tr>
<td>Alt + Enter</td>
<td>Display project properties</td>
</tr>
<tr>
<td>Ctrl + S</td>
<td>Save project</td>
</tr>
<tr>
<td>Ctrl + Shift + S</td>
<td>Save project as</td>
</tr>
</tbody>
</table>
## Workspace Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tab</td>
<td>Switch between Timeline/Storyboard</td>
</tr>
<tr>
<td>Home</td>
<td>Go to the beginning of clip/project</td>
</tr>
<tr>
<td>End</td>
<td>Go to the end of clip/project</td>
</tr>
<tr>
<td>Alt+1</td>
<td>Opens the Magic Clean function</td>
</tr>
<tr>
<td>Alt+2</td>
<td>Opens the Magic Motion function</td>
</tr>
<tr>
<td>Alt+3</td>
<td>Opens the Magic Cut function</td>
</tr>
<tr>
<td>Alt+4</td>
<td>Opens the Magic Music function</td>
</tr>
<tr>
<td>Ctrl + right arrow</td>
<td>Go to next clip in the track (Clip mode)</td>
</tr>
<tr>
<td>Ctrl + left arrow</td>
<td>Go to previous clip in the track (Clip mode)</td>
</tr>
<tr>
<td>Ctrl + C</td>
<td>Copy</td>
</tr>
<tr>
<td>Ctrl + X</td>
<td>Cut</td>
</tr>
<tr>
<td>Ctrl + V</td>
<td>Paste</td>
</tr>
<tr>
<td>+</td>
<td>Zoom ruler In</td>
</tr>
<tr>
<td>-</td>
<td>Zoom ruler out</td>
</tr>
</tbody>
</table>
### Menu Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt + F</td>
<td>Open File menu</td>
</tr>
<tr>
<td>Alt + E</td>
<td>Open Edit menu</td>
</tr>
<tr>
<td>Alt + V</td>
<td>Open View menu</td>
</tr>
<tr>
<td>Alt + T</td>
<td>Open Capture menu</td>
</tr>
<tr>
<td>Alt + P</td>
<td>Open Playback menu</td>
</tr>
<tr>
<td>Alt + H</td>
<td>Open Help menu</td>
</tr>
</tbody>
</table>

### Smart Guide Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + Alt + T</td>
<td>Display Trim options</td>
</tr>
<tr>
<td>Ctrl + Alt + S</td>
<td>Display Speed options</td>
</tr>
<tr>
<td>Ctrl + Alt + C</td>
<td>Display Color options</td>
</tr>
<tr>
<td>F2</td>
<td>Display PiP Modification Options/Title Designer</td>
</tr>
</tbody>
</table>

### Settings Panel Hotkey

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + P</td>
<td>Take a snapshot</td>
</tr>
</tbody>
</table>
# Main Panel Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1</td>
<td>Help</td>
</tr>
<tr>
<td>Ctrl + + (plus)</td>
<td>Increase volume</td>
</tr>
<tr>
<td>Ctrl + - (minus)</td>
<td>Decrease volume</td>
</tr>
<tr>
<td>Ctrl + Backspace</td>
<td>Mute/unmute</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete selected item(s)</td>
</tr>
<tr>
<td>Ctrl + Z</td>
<td>Undo</td>
</tr>
<tr>
<td>Ctrl + Y</td>
<td>Redo</td>
</tr>
<tr>
<td>Shift + F12</td>
<td>Show Hotkey list help</td>
</tr>
<tr>
<td>F9</td>
<td>Switch to Capture mode</td>
</tr>
<tr>
<td>F10</td>
<td>Switch to Edit mode</td>
</tr>
<tr>
<td>F11</td>
<td>Switch to Produce mode</td>
</tr>
</tbody>
</table>
### Library Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>F5</td>
<td>Open Media Room</td>
</tr>
<tr>
<td>F6</td>
<td>Open Effect Room</td>
</tr>
<tr>
<td>F7</td>
<td>Open Title Room</td>
</tr>
<tr>
<td>F8</td>
<td>Open Transition Room</td>
</tr>
<tr>
<td>Shift + F9</td>
<td>Open Audio Mixing Room</td>
</tr>
<tr>
<td>Shift + F10</td>
<td>Open Voice-Over Recording Room</td>
</tr>
<tr>
<td>Shift + F11</td>
<td>Open Chapter-Setting Room</td>
</tr>
<tr>
<td>Ctrl + Enter</td>
<td>Display media in Media Viewer</td>
</tr>
<tr>
<td>Ctrl + A</td>
<td>Select all</td>
</tr>
<tr>
<td>Ctrl + Tab</td>
<td>Switch between filters</td>
</tr>
<tr>
<td>Ctrl + D</td>
<td>Detect scenes</td>
</tr>
<tr>
<td>Ctrl + Q</td>
<td>Load media file(s)</td>
</tr>
<tr>
<td>Ctrl + W</td>
<td>Load a media folder</td>
</tr>
</tbody>
</table>
### Capture Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + R</td>
<td>Record</td>
</tr>
<tr>
<td>Ctrl + /</td>
<td>Stop recording</td>
</tr>
<tr>
<td>Space bar</td>
<td>DV play/pause</td>
</tr>
<tr>
<td>Ctrl + , (comma)</td>
<td>DV rewind</td>
</tr>
<tr>
<td>Ctrl + . (period)</td>
<td>DV fast forward</td>
</tr>
<tr>
<td>Ctrl + /</td>
<td>DV stop</td>
</tr>
</tbody>
</table>

### Voice-Over Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + H</td>
<td>Fade in</td>
</tr>
<tr>
<td>Ctrl + J</td>
<td>Fade out</td>
</tr>
<tr>
<td>Ctrl + R</td>
<td>Start recording</td>
</tr>
<tr>
<td>Ctrl + /</td>
<td>Stop recording</td>
</tr>
</tbody>
</table>
## Preview Window Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Space</td>
<td>Play/pause</td>
</tr>
<tr>
<td>Ctrl + /</td>
<td>Stop</td>
</tr>
<tr>
<td>, (comma)</td>
<td>Previous frame</td>
</tr>
<tr>
<td>. (period)</td>
<td>Next frame</td>
</tr>
<tr>
<td>Page Up</td>
<td>Skip 1 second backward</td>
</tr>
<tr>
<td>Page Down</td>
<td>Skip 1 second forward</td>
</tr>
<tr>
<td>Ctrl+F</td>
<td>Fast forward</td>
</tr>
<tr>
<td>[</td>
<td>Mark in</td>
</tr>
<tr>
<td>]</td>
<td>Mark out</td>
</tr>
<tr>
<td>Ctrl + T</td>
<td>Split</td>
</tr>
<tr>
<td>Ctrl + G</td>
<td>Goto timecode</td>
</tr>
<tr>
<td>Ctrl + E</td>
<td>Display Precise Cut trimmer (when enabled)</td>
</tr>
<tr>
<td>F3</td>
<td>Switch to Movie mode</td>
</tr>
<tr>
<td>F4</td>
<td>Switch to Clip mode</td>
</tr>
<tr>
<td>Ctrl + Enter</td>
<td>Display media in Media Viewer</td>
</tr>
<tr>
<td>Ctrl + U</td>
<td>Adjust system volume</td>
</tr>
</tbody>
</table>
### Title Designer Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + B</td>
<td>Set text in bold</td>
</tr>
<tr>
<td>Ctrl + I</td>
<td>Set text in italics</td>
</tr>
<tr>
<td>Ctrl + L</td>
<td>Left-align text</td>
</tr>
<tr>
<td>Ctrl + R</td>
<td>Right-align text</td>
</tr>
<tr>
<td>Ctrl + E</td>
<td>Center-align text</td>
</tr>
<tr>
<td>Ctrl + T</td>
<td>Show/hide TV Safe lines</td>
</tr>
<tr>
<td>Ctrl + G</td>
<td>Show/hide Gridlines</td>
</tr>
<tr>
<td>Ctrl + M</td>
<td>Show/hide Title mask</td>
</tr>
</tbody>
</table>

### PiP Designer Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + T</td>
<td>Show/hide TV Safe lines</td>
</tr>
<tr>
<td>Ctrl + G</td>
<td>Show/hide Gridlines</td>
</tr>
</tbody>
</table>
**FAQ**

Answers to the most frequently asked questions concerning CyberLink PowerDirector are listed below. If you require further information, see Technical Support on p.148.

1. **What's new in PowerDirector?**

New Features:

- **RichVideo** Speeds up the video editing process by storing file-specific information created by the Magic Cut or Scene Detection functions to file or to cache. When these functions are performed in the future, PowerDirector re-uses the stored file information to process the function more quickly.
- **Batch Capturing** provides manual or automatic capturing of a group of clips.
- **SVRT Information** lets users estimate their rendering time by simulating how much of a clip's rendering will be sped up by SVRT-2.
- **Magic Tools** clean video and automate editing of video and audio clips.
- **Setting Chapters** on the timeline makes creating DVD menu chapters easier by including them in the editing process.
- **Lock Timeline** protects timeline tracks from being accidentally moved, changed or deleted.
- **Multi Trim** offers users a manual tool for inserting multiple in and out editing points to a clip.
- **Align To Edge** improves editing accuracy by snapping audio and effects to the start or end of a video clip.

Improved Features:

- Video effects, title effects, and transition effects
- DVD authoring (in CyberLink PowerProducer)
- DV QuickScan
- Video format support
- Video capture device support
2. **What is the difference between CyberLink PowerProducer and CyberLink PowerDirector?**

CyberLink PowerProducer is mainly for users who want to burn the home videos they have saved on their computer, camcorder, or digital camera to DVD/CD so they can share them with friends and family. PowerProducer users generally want a quick solution without learning how to edit video.

CyberLink PowerDirector, on the other hand, allows users to explore their creativity in the field of digital video editing. PowerDirector boasts powerful video editing tools, numerous effects, and audio tracks for a more complete movie creation experience. Like PowerProducer, PowerDirector also exports videos to DVD/CD.

3. **How do I know if my DVD player will play the DVDs I create with PowerDirector?**

Movie titles/discs created by PowerDirector have been thoroughly tested in the Class A verification lab approved by the DVD Forum. This means we are being verified and tested in world class labs that guarantee our compatibility. A DVD player that carries a DVD-video compatible logo should playback any movie discs without any problems.

4. **What file formats can be imported by PowerDirector?**

- **Video**: .avi, .dat, .mpe, .mpg, .mpeg, DivX (requires codec), .wmv
- **Audio**: .mp3, .wav, .wma
- **Photo**: .bmp, .gif, .jpe, .jpeg, .jpg, .tif, .tiff

5. **What movie disc types can be produced by PowerDirector?**

- DVD, DVD folders and disc images
- SVCD/VCD
6. **What is SVRT/SVRT II and when can I use it?**

SVRT (Smart Video Rendering Technology) is a proprietary rendering technology from CyberLink that intelligently recognizes which portions of a movie clip have been modified, and only renders those portions - not the entire video clip - during production. Rendering only the modified portions of a video clip saves time and preserves the original quality of the video. Using SVRT, PowerDirector renders MPEG-1, MPEG-2, and DV-AVI video faster than any other software on the market. (Other video editing software programs have to render the entire video even if one single frame has been modified!)

SVRT II further breaks movie clips into their component video and audio parts, then renders only the audio or video portion that has been modified. This further reduces the amount of time needed for production!

CyberLink’s Smart Video Rendering Technology is available during production when the frame rate, frame size, and file format of video files in your movie are the same (and bitrate is similar). In this case, SVRT is used to render these files. If any clips do not meet the above criteria, they are fully rendered without SVRT.

If you have previously produced a disc using SVRT and the disc encountered compatibility issues with your player, render the video again without using SVRT. (Some players are unable to play back MPEG video with a modified GOP pattern.)

7. **What is “editable DVD”?**

Editable DVD is to make your authored DVD able to be further edited even when it’s already burn on a disc. By applying this technology, you will be able to record your DVD quickly and you will also be able to append new videos, change backgrounds later when you finished it. Editable DVD is 100% compatible with your DVD player.
8. **How do I know if my hardware is compatible with or supported by PowerDirector?**

Check out the hardware approval sheet in the readme file. An updated version can also be found on CyberLink’s website.

9. **Which languages does PowerDirector support?**

PowerDirector supports the languages listed below:
- Chinese, Simplified
- Chinese, Traditional
- English
- French
- German
- Italian
- Japanese
- Korean
- Spanish

10. **Commercial DVDs often contain up to 3 hours of video. How can I use PowerDirector to make a DVD that long?**

Change the video quality setting in the Select Your Disc page of PowerProducer. When you select a video quality, the detailed attributes of that quality setting are displayed at the bottom of the PowerDirector interface. For more information, see Video Qualities on p.169.

11. **Isn't MPEG encoding slow? How does PowerDirector increase production speed?**

Using SVRT, PowerDirector only renders the modified part of a video sequence, without rendering the untouched parts. This speeds up production time considerably. SVRT is the smartest way to render MPEG and still retain the original video quality.
**SVRT2: When Can I Use it?**

SVRT2 can be applied to video clips in the MPEG-1, MPEG-2, and DV-AVI (Type I) formats. In the following conditions, clips (or portions of clips) do not require rendering during production, and SVRT2 can therefore be applied:

- The frame rate, frame size, and file format are the same as those of the destination production profile.
- The bitrate is similar to that of the destination production profile.
- The TV format is the same as that of the destination production profile. For more information, see Set a Video Clip’s Interlacing Format on p.77.

If all of the above conditions are met, SVRT2 can be used. Any clips that do not meet the above criteria are fully rendered without SVRT2.

In the following conditions, clips (or portions of clips) must be rendered during production, and SVRT2 can therefore **not** be applied:

- Adding a title or transition effect
- Modifying the color of a video clip
- Audio profile does not match destination production profile
- Modifying the volume of an audio clip
- Merging two video clips (clips within 2 seconds before or after the merged clips will be rendered)
- Splitting a video clip (clips within 2 seconds before or after the split will be rendered)
- Trimming a video clip (clips within 2 seconds before or after the trimmed clip will be rendered)
Disc Types & Formats

This section describes the different disc types and disc formats that you can use in CyberLink PowerProducer.

Disc Types

In broad terms, discs are divided into CD (which, being the earlier technology, is more widely supported) and DVD (which holds many times the amount of content, but requires a different drive). Following is a brief description of the different disc types supported by CyberLink PowerProducer.

Multisession Discs

Multisession discs allow you to append additional data after the original burning session. PowerProducer creates a multisession disc whenever you burn a CD-R, CD-RW, DVD-R, or DVD+R disc and choose not to close or finalize the disc. Therefore, you can continue to add content to a multisession disc until the disc is full or closed, at which point you can no longer append any further data.

CD Types

CDs contain up to 74/80 minutes of high quality video or 650/700 MB of data.

<table>
<thead>
<tr>
<th>CD Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CD-R</td>
<td>CD-R is a “write once” CD format. CD-RW burners and most new DVD burners can write in CD-R, and most DVD players can also read this format.</td>
</tr>
<tr>
<td>CD-RW</td>
<td>CD-RW is an erasable CD format. CD-RW burners and most new DVD burners can write in CD-RW, and most DVD players can also read this format.</td>
</tr>
</tbody>
</table>
DVD Types

DVD is a high capacity disc that holds anywhere from 4.7-17 GB of data, or from roughly 2-8 hours of video (depending on the type of DVD and the video quality setting). Using the High Quality setting, you can expect to be able to record 1-2 hours of video.

DVDs can be played on DVD players and computers equipped with DVD drives. For more detailed information on DVD-R/RW formats, see www.dvdrhelp.com/dvd or other web sources. For more detailed information on DVD+R/RW formats, see www.dvdrw.com or other web sources.

<table>
<thead>
<tr>
<th>DVD Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DVD-R</td>
<td>DVD-R, a “write once” DVD format, is a competitor product to DVD+R, and is therefore not compatible with that format. Some new DVD burners can write in both DVD-R and DVD+R, and most DVD players can read both formats.</td>
</tr>
<tr>
<td>DVD-RW</td>
<td>DVD-RW, an erasable DVD format, is a competitor product to DVD+RW, and is therefore not compatible with that format. Some new DVD burners can write in both DVD-RW and DVD+RW, and most DVD players can read both formats.</td>
</tr>
<tr>
<td>DVD+R</td>
<td>DVD+R, a “write once” DVD format, is a competitor product to DVD-R, and is therefore not compatible with that format. Some new DVD burners can write in both DVD-R and DVD+R, and most DVD players can read both formats.</td>
</tr>
<tr>
<td>DVD+RW</td>
<td>DVD+RW, an erasable DVD format, is a competitor product to DVD-RW, and is therefore not compatible with that format. Some new DVD burners can write in both DVD-RW and DVD+RW, and most DVD players can read both formats.</td>
</tr>
<tr>
<td>DVD-RAM</td>
<td>DVD-RAM is an erasable DVD format that can be erased about 100,000 times. While DVD-RAM has technological advances, it is incompatible with many DVD burners and players.</td>
</tr>
</tbody>
</table>
## Disc Formats

Below is a description of the formats that CyberLink PowerProducer supports for burning discs:

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DivX</td>
<td>DivX is a video file format based on MPEG-4 technology. DivX creates a very small video that can be attached in an email, played back on a media player, viewed on a TV, or written to VHS tape. The DivX codec can be downloaded for free from the DivX website at <a href="http://www.divx.com/divx/">www.divx.com/divx/</a></td>
</tr>
<tr>
<td>DVD-Video</td>
<td>DVD-Video is the most widely supported DVD movie format, which can be played on almost all DVD players.</td>
</tr>
<tr>
<td>DVD-VR</td>
<td>A video format on DVD-RW or DVD-RAM discs. DVD-VR discs can be played on a DVD player with the RW Compatible logo.</td>
</tr>
<tr>
<td>DVD+VR</td>
<td>A video format on DVD+R/RW, DVD-R/RW discs. DVD+VR discs can be played on a DVD-Video player.</td>
</tr>
<tr>
<td>SVCD</td>
<td>SVCD (Super Video Compact Disc) is a CD video format that uses MPEG compression. SVCD offers much higher video quality than VCD. It can hold 35 minutes of video, and can contain menus and chapters like a DVD, as well as slide shows with background audio. SVCDs can be played on a PC with DVD playback software, and on some standalone DVD players.</td>
</tr>
</tbody>
</table>
VCD | VCD (video compact disc) is a CD video format that uses MPEG compression. VCD contains audio and video of a quality about the same as that of VHS, and also contains menus and chapters like a DVD. VCD can be played on a PC with VCD/MPEG playback software and on most stand-alone DVD players.
Disc Type/Format Compatibility

Since some commercial CD players cannot play CD-RWs, it is recommended that you use CD-R/CD+R discs to burn music CDs.

It is recommended that you use DVD-RW or DVD-RAM discs for video in DVD-VR format. DVD-VR discs can be played on a DVD player with the -VR Compatible logo.

It is recommended that you use DVD+R/RW or DVD-R/RW discs for video in DVD+VR format. DVD+VR discs can be played on a DVD-Video player.
Video Formats & Qualities

When you burn video to disc, you must take into consideration not only the quality you want to use, but also the TV format of the country or region in which you want to watch the movie disc you burn. The section below offers information on both of these topics, allowing you to burn video discs that suit your playback capabilities.

TV Formats

The two TV formats (NTSC and PAL) have been adopted as standards by television broadcasters around the world. The main difference between the two formats is the number of frames per second they offer: 30 in NTSC, and 25 in PAL. This difference means that a movie recorded in NTSC format is unplayable by a PAL player and vice versa.

Fortunately, the question of whether to use PAL or NTSC television format for your disc can be reduced to the following simple question:

- **In which country or region do you plan to play this disc?**

Since all countries use either the NTSC or PAL format, knowing the location in which the disc will be played pretty much resolves this issue for you. By selecting the desired country or region, the television format is automatically set.

**Note:** Generally speaking, the United States, Japan, Canada, and Mexico use NTSC, while Germany, Great Britain, South America, Australia, and most of Western European and Asian countries use PAL.
Video Qualities

The different video quality settings (HQ, SP, and LP) available in CyberLink PowerDirector result in a final picture of higher or lower quality and a movie file of larger or smaller size. Better quality video also demands more from your computer and limits the video duration you can burn to disc. Below is a comparison of the length of video you can expect to be able to burn to a DVD using the different qualities:

- **HQ**: 60 minutes
- **SP**: 120 minutes
- **LP**: 180 minutes

For the best possible image quality in your final production, select the highest video quality that will allow your production to fit onto the disc type you are using. Your ultimate choice of video quality, however, should be based both on the image quality you want in your final production and on the processing power of your computer.
The glossary provides definitions of terms used in this user’s guide that you may find unfamiliar.

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>chapter</td>
<td>A marker set in a video clip in order allow viewers to jump to that specific point for navigation purposes.</td>
</tr>
<tr>
<td>clip</td>
<td>A video, audio, or image file that has been loaded into PowerDirector’s Library for use in your movie.</td>
</tr>
<tr>
<td>color filter</td>
<td>An option in PiP effects that makes a selected color transparent, allowing the underlying clip to show through in the transparent areas.</td>
</tr>
<tr>
<td>deinterlacing</td>
<td>Methods used to reduce or eliminate the decrease in video quality caused by interlacing.</td>
</tr>
<tr>
<td>DV</td>
<td>(Digital Video) Refers to the capturing, manipulation and storage of video in digital formats. The DV format is an international standard for consumer use created in 1995 by a consortium of companies.</td>
</tr>
<tr>
<td>DVD folder</td>
<td>A folder containing all of the media files for your production that can be burned to a disc for storage.</td>
</tr>
<tr>
<td>Term</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>GOP pattern</td>
<td>(Group of Pictures pattern) A pattern in MPEG encoding made up of groups of pictures (consisting of I-, B-, and P-frames), which have certain dependent relationships during encoding. Changes to this pattern can cause playback errors in some players.</td>
</tr>
<tr>
<td>hold time</td>
<td>Used to describe the time a moving effect (PiP or title effect) remains stationary on the screen.</td>
</tr>
<tr>
<td>HQ</td>
<td>(High Quality) The highest video quality you may select in PowerDirector.</td>
</tr>
<tr>
<td>hue</td>
<td>The attribute of a color that distinguishes it from other colors.</td>
</tr>
<tr>
<td>interlacing</td>
<td>Flickering or artefacts caused by the way video signals are broadcast. (Each frame of video is made up of a number of lines. When video frames are broadcast, the odd lines of the screen display are illuminated first, then the even lines. This causes the interlacing problem, which is most evident when the video contains motion.)</td>
</tr>
<tr>
<td>key frame</td>
<td>A key frame is defined as a frame in a video sequence that does not require information from a previous frame for decompression. More key frames yield better video quality but require greater amounts of disk space.</td>
</tr>
<tr>
<td>LP</td>
<td>(Long Play) The lowest video quality you may select in PowerDirector.</td>
</tr>
<tr>
<td>menu</td>
<td>A page on a DVD that contains links to the chapters the DVD contains.</td>
</tr>
<tr>
<td>Term</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>MPEG</strong></td>
<td>(Moving Picture Experts Group) A family of international standards used for coding audio/video information into digital format. Currently, MPEG-2 is the standard for digital video formats and MP3 for strictly digital audio formats.</td>
</tr>
<tr>
<td><strong>non-realtime capture</strong></td>
<td>Non-realtime capture continues processing video after the video capture playback stops in order to ensure that no frames are dropped. Capturing video at a higher speed reduces processing time, but yields video of a lower quality. Capturing better quality video requires more CPU power and more time to complete.</td>
</tr>
<tr>
<td><strong>NTSC</strong></td>
<td>(National Television Systems Committee) A standard format adopted by the FCC for television broadcasts in the United States, Japan, Canada, and Mexico. NTSC offers 525 lines of resolution per frame at 30 fps.</td>
</tr>
<tr>
<td><strong>PAL</strong></td>
<td>(Phase Alteration Line) The standard format for television broadcasts in Germany, Great Britain, South America, Australia, and most of Western European and Asian countries. PAL offers 25 frames per second.</td>
</tr>
<tr>
<td><strong>realtime capture</strong></td>
<td>Realtime capture completes capturing during playback of the original video. Realtime capture requires high processing speeds and risks dropped frames.</td>
</tr>
<tr>
<td><strong>saturation</strong></td>
<td>The richness of a color.</td>
</tr>
<tr>
<td><strong>slide</strong></td>
<td>An individual photo within a slide show. Slides are contained within albums.</td>
</tr>
</tbody>
</table>
### Term | Description
---|---
slide show | A presentation that can include both photos (called slides) and effects, such as transitions and background music. The photos and effects in a slide show are contained in units called albums, which can contain any number of photos, as well as transitions and music.

SP | (Standard Play) The median video quality in PowerDirector, inferior to HQ but superior to LP.

streaming | Streaming is a data transfer technology that allows viewers to play a file received over the Internet without downloading it onto their own computer.

SVRT, SVRT II | (Smart Video Rendering Technology) A proprietary movie rendering technology from CyberLink that only compiles those portions of a movie clip that have been modified, reducing the amount of time needed for production. SVRT II is able to discern between audio and video portions of a movie clip, and only renders the portion that has been modified. For a fuller discussion of SVRT/SVRT II, see What is SVRT/SVRT II and when can I use it? on p.160.

Type I | Method of storing DV data in AVI format that was defined by Microsoft. This format stores data (i.e. video and audio) as a single AVI stream. It offers better compression, but is newer, and therefore compatible with fewer systems than Type II.
<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type II</td>
<td>Method of storing DV data in AVI format that was defined by Microsoft. This format stores data (i.e. video and audio) as a single video stream and 1-4 audio streams to store DV data. It offers wider compatibility, but uses an older compression than Type I. This format requires slightly more processing time to split the video/audio stream while capturing.</td>
</tr>
<tr>
<td>volume key</td>
<td>A point you can set within an audio track in order to increase or decrease volume beginning at that point.</td>
</tr>
<tr>
<td>WMV</td>
<td>(Windows Media Audio) A Windows streaming audio format used for files destined to be downloaded or played over the Internet.</td>
</tr>
</tbody>
</table>
Copyright Notices

Following are copyright notices for references to copyrighted materials used in this document.

Dolby Laboratories

Manufactured under license from Dolby Laboratories. “Dolby”, and the double-D symbol are trademarks of Dolby Laboratories. Confidential unpublished works. Copyright 1992-1999 Dolby Laboratories. All rights reserved.

Intel License Agreement For Open Source Computer Vision Library

Copyright © 2000, Intel Corporation, all rights reserved. Third party copyrights are property of their respective owners.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

Redistribution's of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

Redistribution's in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

The name of Intel Corporation may not be used to endorse or promote products derived from this software without specific prior written permission.
This software is provided by the copyright holders and contributors “as is” and any express or implied warranties, including, but not limited to, the implied warranties of merchantability and fitness for a particular purpose are disclaimed. In no event shall Intel or contributors be liable for any direct, indirect, incidental, special, exemplary, or consequential damages (including, but not limited to, procurement of substitute goods or services; loss of use, data, or profits; or business interruption) however caused and on any theory of liability, whether in contract, strict liability, or tort (including negligence or otherwise) arising in any way out of the use of this software, even if advised of the possibility of such damage.
Index

B
batch capturing 23  
  automatic 23  
  manual 27  
border in PiP effects 93  
burning, producing a movie for 117

A

adding
  audio clips to workspace 58  
  clips to workspace 56  
  color boards to workspace 57  
  images to workspace 56  
title effects to Timeline 59  
transition effects to Timeline 59  
video effects to Timeline 58
aliases 49
align clips in Timeline 61
analog video capture options 16
audio
  adding clips to the workspace 58
  capture options 17
  compression bitrate 133
  Magic Music 87
Audio Mixer 79
  adding fade effect in 80
  mixing audio in 79
Audio Mixing Room 44
automatic batch capture 23
AVI
  producing files 119
  production profiles 129, 131

C

capture
  automatic batch 23, 27
  batch 23
  from CD 34
  from DV device 21
  from microphone 33
  from PC camera 32
  from TV 30
  from webcam 32
  limit options 14
  media 11
  mode 12
  preferences 13
  single scene 21
capture options 14
  analog video options 16
  audio 17
  CD 19
  deleting captured files 19
  detecting scenes 20
  fade-ins in 17
  fade-outs in 17
  limits 14
  microphone 19
  naming captured files 19
TV 16
webcam 18
captured clip options 19
CD
capture profile setup 19
capturing from 34
types 163
vs. DVD 163
CD+R, use for burning music 167
CD-R
description 163
use for burning music 167
CD-RW
description 163
limitation of 167
Chapter Setting Room 45
chapters
definition 170
setting 63
clear workspace 38
clips
definition 170
previewing in Media Editor 112
previewing in preview window 110
trimming 69
viewing properties in Library 50
CLNR 84
color boards, adding to the workspace 57
color filter, adding to PiP effects 99
color filter, definition 170
compatibility of file formats & disc types 167
copying
clips in workspace 60
hotkey shortcut 151
create new project file 38
creating
MPEG production profile 132
customizing
MPEG production profile 132
cutting
clips in workspace 60
hotkey shortcut 151
CyberLink Noise Reduction 84

D
default durations, setting 42
deinterlacing 133
deinterlacing, definition 170
deleting
a captured file 19
files from disk 48
detecting scenes
by changing timecodes 52
in captured clips 20
in video clips 51
setting sensitivity 51
disc types
compatible video formats 167
supported 159, 163
DivX
creating 124
description 165
producing 124
where to download codec 165
dragging
clips in the workspace 60
to trim clips 71
to trim effects 90
duration
defaults for image files and effects 42
minimum for batch capture 29
of capture 14
of effects 89
of music clips in Magic Music 87
of video by quality 169
of video in Magic Cut 86
sort by in Library 47
DV
camcorder, capturing from 21
definition 170
parameters 13
tape, writing to 143
DV-AVI
detecting scenes in 51
interlaced video in 77
producing 119
DVD
interlaced video in 77
types 164
vs. CD 163
DVD folder, definition 170
DVD+R
description 164
use with DVD+VR 167
DVD+RW
description 164
use with DVD+VR 167
use with DVD-VR 167
DVD+VR
compatible discs 167
description 165
DVD-R
description 164
use with DVD+VR 167
DVD-RAM
description 164
use with DVD+VR 167
DVD-VR
compatible discs 167
description 165
EagleVision
photos 82
video 83
editable DVD, what is 160
Effect Room, description 44
Effect track
adding effects 58
description 54
effects
previewing in Media Editor 112
previewing in preview window 110
setting duration 89
eyedropper tool 99
F
fade-in
adding to audio clips 80
in audio capture 17
fade-out
adding to audio clips 80
in audio capture 17
FAQ 158
fax number for technical support 148
file
  formats supported 159
  preferences 40
font in title effects, modifying 102

G

general preferences 40, 41
generating
  AVI files 119
  DivX files 124
  MPEG files 126
  RealVideo files 136
  WMV files 134
glossary 170
GOP pattern 171

H

High Quality 171
high quality 133
High Quality, video duration of 169
high speed 133
hold time
  definition 171
  setting for effects 88
hotkeys 150
hours of technical support 149
HQ 171
  video duration of 169

I

images
  adding to workspace 56
  EagleVision 82
interlacing
  definition 171
  format, setting 77
intervals, scanning for 24
in-track audio mixing 78
introduction 1

K

key frame 171

L

languages supported 161
Library
  aliases in 49
  deleting files from disk in 48
  description 43
  detecting scenes in 51
  loading media into 46
  removing clips from 48
  restricting display in 47
  sorting clips in 47
  loading media 46
lock tracks in the Timeline 54
Long Play quality
  definition 171
  video duration of 169

4
Index

LP 171

M

Magic Clean
  audio 84
  images 82
  video 83
Magic Cut 86
Magic Motion 85
Magic Music 87
manual batch capture 27
masking title effects 106
master audio level, setting 33
Media Editor 111
  previewing effects in 112
  trimming video in 72
Media Room 44
Media Viewer 111
  previewing in 112
  previewing movie in 66
microphone
  capture profile setup 19
  capturing from 33
mixing
  in Audio Mixer 79
  in-track 78
modes in PowerDirector 8
modifying effects
  PiP 92
  title 102
  video 91
motion
  adding to image clip 85
  of PiP effects, modifying 97
movie
  previewing in Media Viewer 66
  previewing in preview window 65
movie-making process 3
moving clips in workspace 60
MPEG
  definition 172
  producing files 126
  production profiles 132
multisession discs 163
Music track
  adding clips 58
  description 54
muting
  audio tracks 73
  entire track 73

N

da

ame

captioned files 19
narration, recording 35
new
  features 158
  project file 38
  workspace 38
noise removal 133
non-realtime capture, definition 172
NTSC 172
  countries that use 168
  frame rate 168

O

OEM versions 10
open project file 38
Original version window 81
Output version window 81

P

PAL 172
  countries that use 168
    frame rate 168
pan an image 85
pasting clips in workspace 60
PC camera, capturing from 32
PhotoNow! 76
photos
  EagleVision 82
PiP effects
  adding color filter 99
  modifying border 93
  modifying motion 97
  modifying position 101
  modifying size 101
  modifying speed 92
  modifying transparency 101
  shadows 95
PiP track
  adding color boards 57
  adding images 56
  adding video 56
  description 54
position of PiP effects, modifying 101
PowerDirector
  interface 7
  modes 8
  new features 158
  versions 10
PowerProducer 118
Precise Cut in trimming 72
preferences
  capture 13
  file 40
  general 40, 41
pre-production
  ready to burn 7
preview window
  previewing clips in 110
  previewing effects in 110
  previewing movie in 65
previewing
  clips in preview window 110
  effects in Media Editor 112
  effects in preview window 110
  in Media Viewer 112
  movie in Media Viewer 66
  movie in preview window 65
producing
  AVI files 119
  before 115
  DivX files 124
  MPEG files 126
  QuickTime files 139
  RealVideo files 136
  WMV files 134
  your movie 113
production
  mode 114
  profiles, AVI 129, 131
  Wizard 115
profiles
  AVI 129, 131
  QuickTime 141
program interface 7
project file
  create 38
Index

open 38
properties 39
save 38
project file, description 8
properties
  of clips in Library 50
  project file 39

Q

quality vs speed of video 133
QuickScan 24
QuickTime
  file production 139
  profiles 141

R

realtime capture, definition 172
RealVideo file production 136
recording a voice-over 35
red-eye removal 82
registration 5
removing
  clips from Library 48
  clips from workspace 62
renaming clips 49
replacing effects in Timeline 62
resizing the ruler 54
restoring volume levels in audio tracks 80
restricting display of clips in Library 47
ripping CD tracks 34
ruler, resizing 54

S

saturation, definition 172
save project file 38
scanning for intervals 24
scene detection 51
Scene with zoom/pan/motion 86
Scenes with long duration 86
Scenes with people speaking 86
select clips in the workspace 60
setting
  chapters 63
  default durations 42
  master audio level 33
  undo levels 41
shadows
  in PiP effects 95
  in title effects 107
size
  limit for captures 14
  of PiP effects, modifying 101
slide show 173
slides 172
slow-motion, adding to video 74
Smart Video Rendering Technology 160
smoothing 133
snapshot
  default destination 40
  default filename 40
  of video clip 73
sorting clips in the Library 47
SP quality 173
  video duration of 169
speed
  of PiP effects 92
  of video clips 74
  vs. quality of video 133
splitting clips 68
Standard Play quality 173
  video duration of 169
Storyboard view 55
streaming
  definition 173
  file production, QuickTime 139
  file production, RealVideo format 136
  file production, WMV format 134
  profile, QuickTime 141
stretching audio 75
SVCD
  interlaced video in 77
SVRT
  definition 173
  SVRT II, what is 160
  using in disc production 120
  viewing in project 64
  what is 160
  when available 160
system requirements 9

tape, writing to 143
technical support phone number 149
time limit for captures 14
Timeline
  adding title effects 59
  adding transition effects 59
  adding video effects 58
  align clips 61
  lock tracks 54
  unlock tracks 54
  view 53
title effects
  adding to Timeline 59
  masking 106
  modifying font 102
  replacing in Timeline 62
  shadows 107
Title Room 44
Title track
  adding titles 59
  description 54
tracks
  descriptions 54
  lock 54
  unlock 54
transition effects
  adding to Timeline 59
  replacing in Timeline 62
Transition Room 44
transparency of PiP effects, modifying 101
trimming
  audio & video clips 69
  dragging an edge 71
  Precise Cut 72
  video or audio 69
TV
  capture options 16
  capturing from 30
Type I AVI format, definition 173
Type II AVI format, definition 174
U

UI, default 7
Undo levels, setting 41
uninstall your software 6
unlock a track in the Timeline 54
Update SVRT Info 64

V

VCD
description 166
versions of PowerDirector 10
video
adding to workspace 56
EagleVision 83
overlay 13
size 141
video clips
detecting scenes in 51
snapshot of 73
video compression rate 132
video effects
adding to Timeline 58
modifying 91
replacing in Timeline 62
video qualities
hint on selecting 169
video duration of 169
video size 132, 141
Video track
adding color boards 57
adding images 56
adding transitions 59
adding video 56
description 54
viewing
clip properties 50
project properties 39
SVRT information in project 64
Voice track
adding audio 58
description 54
voice-over recording 35
Room 35
Voice-Over Recording Room 45
volume
changing in Audio Mixer 79
changing in-track 78
volume keys
adding to an audio track 78
definition 174

W

webcam
capturing from 32
video capture options 18
website for technical support 148
what’s new in PowerDirector 158
where to begin reading 2
wind noise, filter 84
Windows AVI, producing 122
WMV
definition 174
file production 134
workspace
adding clips to 56
new 38
Storyboard view 55
Timeline view 53
CyberLink PowerDirector 4

write to DV tape 143

Z

zoom an image 85